Contents

Overview of ERDAS APOLLO .......................................................................................... 5
About Us ...................................................................................................................... 9

Installing and Configuring ERDAS APOLLO .............................................................. 11
Installation Components ............................................................................................ 11
Before You Install ........................................................................................................ 11
Antivirus Software Requirements ................................................................................ 12
Installing Windows Identity Foundation (WIF) .......................................................... 12
Configuring Windows Server Roles, Role Services and Features ............................. 13
Configuring Windows Web Server (IIS) ...................................................................... 14
Configuring Secure Sockets Layer (SSL) .................................................................... 16
Preparing Your Database .............................................................................................. 18
ERDAS Foundation ........................................................................................................ 21
Licensing ERDAS APOLLO ............................................................................................ 22
Installing and Configuring ERDAS APOLLO Server ................................................... 23
Installing ERDAS APOLLO Server .............................................................................. 23
Configuring ERDAS APOLLO Server ......................................................................... 32
Installing and Configuring ERDAS APOLLO Server in a Cluster ............................... 54
Cluster Installation and Configuration ......................................................................... 57
Configure Subcomponents for the Cluster .................................................................... 68
Accessing Shared Cluster Configuration Resources ................................................... 69
Configure Application Request Routing (ARR) ......................................................... 69
Additional Configuration .............................................................................................. 88
Testing Your Installation of ERDAS APOLLO Server ................................................ 89
Installing ERDAS APOLLO Data Manager .................................................................. 90

Upgrading ERDAS APOLLO ...................................................................................... 93
Upgrading from ERDAS APOLLO 2011 ..................................................................... 93
Upgrading from ERDAS APOLLO 2013 ..................................................................... 94
Upgrading from ERDAS APOLLO 2013 SP1 or later .................................................. 95
Uninstalling ERDAS APOLLO - Remove Configuration Option .................................. 95
Uninstalling ERDAS APOLLO - Leave Configuration Option ...................................... 96
Migrating Customized Properties to ERDAS APOLLO 2015 ...................................... 97

Uninstalling ERDAS APOLLO .................................................................................... 99
Removing ERDAS Foundation ................................................................................... 100

Troubleshooting ERDAS APOLLO .......................................................................... 103
Troubleshooting Installation Errors .............................................................................. 103
Logging Installation Errors ......................................................................................... 103
Error Initializing Catalog Database by Configuration Wizard .................................... 105
Troubleshooting Runtime Errors ................................................................................ 106


Overview of ERDAS APOLLO

About ERDAS APOLLO

ERDAS APOLLO is an enterprise-class, comprehensive data management, analysis, and delivery system enabling an organization to catalog, search, discover, process, and securely disseminate massive volumes of both file-based and web-enabled data. This solution consistently delivers virtually any digital object faster and with less hardware than competing server-based products. An interoperable OGC/ISO-based application that implements an out-of-the-box service-oriented architecture (SOA), ERDAS APOLLO is the solution for data management in the overall Hexagon Geospatial server story.

Available in three product tiers, ERDAS APOLLO suits a spectrum of organizations – integrating easily with other geospatial software and offering unparalleled performance even when handling massive data archives and many users.

ERDAS APOLLO Essentials is the fastest geospatial image and LIDAR server in the world. A single server with standard hardware can serve terabytes of data to thousands of concurrent users. ERDAS APOLLO Essentials works with your GIS to provide geospatial data as quickly as possible. Examples of ERDAS APOLLO Essentials in action can be seen at http://demo-apollo.hexagongeospatial.com/erdas-apollo/.

ERDAS APOLLO Advantage is a comprehensive data management and delivery solution providing remarkable business value. This OGC/ISO standards-based solution can organize, securely manage and disseminate data within databases and also massive volumes of dynamic and static images, point cloud data, terrain, vector data, third party web services, and any digital resource in the enterprise. ERDAS APOLLO Advantage is scalable through clustering to meet an organization’s specific needs, ensuring unprecedented performance even when handling the largest data archives.

ERDAS APOLLO Professional is the most advanced product tier of ERDAS APOLLO. It offers on-the-fly geoprocessing through a powerful implementation of the OGC Web Processing Service (WPS) specification. Users can run an entire model, such as change detection, site analysis, or elevation change, completely contained within a single web processing service (WPS). ERDAS APOLLO Professional is unrivaled in the complexity of algorithms stored under the hood.
## Overview of ERDAS APOLLO

### Documentation for ERDAS APOLLO

The following documents are installed (or are available for installation) with the product, or they are provided on the delivery media:

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERDAS APOLLO Installation and Configuration Guide</td>
<td>This document contains instructions and descriptions for installing and initially configuring ERDAS APOLLO. This includes pre-installation, system configuration, installation and configuration of applications via Setup Manager, and some manual post installation configuration. Post installation configuration content is limited to configuration activities that only need to be done once or very rarely. All other configuration and administration related content is described in the ERDAS APOLLO Administrator Guide.</td>
</tr>
<tr>
<td>ERDAS APOLLO Administrator Guide</td>
<td>This document contains instructions and descriptions for configuring and maintaining an ERDAS APOLLO system after the initial installation and configuration. The primary focus of this document is administration of an ERDAS APOLLO server/system. Content related to how to use ERDAS APOLLO to manage data or services is described in either the ERDAS APOLLO Server User Guide or the ERDAS APOLLO Data Manager User Guide.</td>
</tr>
<tr>
<td>ERDAS APOLLO Server User Guide</td>
<td>This document contains instructions and descriptions for using ERDAS APOLLO tools, utilities and applications to manage data and services. This document covers all aspects of using ERDAS APOLLO except for ERDAS APOLLO Data Manager which has its own dedicated User Guide. The ERDAS APOLLO Server User Guide includes documentation for foundational concepts such as web services, OGC services, data formats and coordinate references systems. It also as includes documentation for using the ERDAS APOLLO Catalog Web Interface, the ERDAS APOLLO Streaming Test Page and the ERDAS APOLLO Style Editor.</td>
</tr>
<tr>
<td>ERDAS APOLLO Data Manager User Guide</td>
<td>This document contains instructions and descriptions for using ERDAS APOLLO Data Manager. ERDAS APOLLO Data Manager is designed to be the primary day to day user interface for managing data and services in ERDAS APOLLO.</td>
</tr>
<tr>
<td>ERDAS APOLLO Supported Environments</td>
<td>A PDF file that lists the supported software configurations (required and optional) for the product.</td>
</tr>
</tbody>
</table>
Overview of ERDAS APOLLO

<table>
<thead>
<tr>
<th><strong>ERDAS APOLLO Release Notes</strong></th>
<th>A PDF file that lists the enhancements for the current release.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ERDAS APOLLO Issues Resolved</strong></td>
<td>A PDF file that lists the product defects that have been fixed for the current release.</td>
</tr>
</tbody>
</table>

The current versions of the Supported Environments, Release Notes, and Issues Resolved documents are available on the Contact Support https://sgisupport.intergraph.com/infcet/index?page=contact_support page. They can also be accessed via links on the Intergraph Setup Manager dialog.

In This Section
About Us ........................................................................................................................................... 9
About Us

Hexagon Geospatial helps you make sense of the dynamically changing world. Hexagon Geospatial provides the software products and platforms to a large variety of customers through direct sales, channel partners, and Hexagon businesses, including the underlying geospatial technology to drive Intergraph Security, Government & Infrastructure (SG&I) industry solutions. Hexagon Geospatial is a division of Intergraph Corporation.

CUSTOMERS. Globally, a wide variety of organizations rely on our products daily including local, state and national mapping agencies, transportation departments, defense organizations, engineering and utility companies and businesses serving agriculture and natural resource needs. Our portfolio enables these organizations to holistically understand change and use information to make mission and business-critical decisions.

TECHNOLOGY. Our priority is to deliver products and solutions that make our customers successful. Hexagon Geospatial is focused on developing leading-edge technology that is easily configurable. Through extensible, scalable and collaborative products, we enable you to transform multi-source content into dynamic and actionable information. We are constantly re-conceptualizing and improving our products.

PARTNERS. As an organization, we are partner-focused, working alongside our channel to ensure we succeed together. We provide the right tools, products and support to our business partners so that they may successfully deliver sophisticated solutions for their customers. We recognize that we greatly extend our reach and influence by cultivating channel partner relationships both inside and outside of Hexagon.

TEAM. As an employer, we recognize that the success of our business is the result of our highly motivated and collaborative staff. At Hexagon Geospatial, we celebrate a diverse set of people and talents; and we respect people for who they are and the wealth of knowledge they bring to the table. We retain talent by fostering individual development and ensuring frequent opportunities to learn and grow.

HEXAGON. Hexagon Geospatial plays a key role in Hexagon’s multi-industry focus, leveraging the entire portfolio for a wide variety of geospatial needs. Hexagon is a leading global provider of design, measurement and visualization technologies. Synergistic thinking is encouraged across all levels and functions at Hexagon companies, so that we all respond better and faster to our shared customer’s needs.

For more information, visit www.hexagongo spatial.com (http://www.hexagongo spatial.com) and www.hexagon.com (http://www.hexagon.com).
Overview of ERDAS APOLLO
Installing and Configuring ERDAS APOLLO

This section instructs you on how deploy to a new installation of ERDAS APOLLO. If you are upgrading a previous version of ERDAS APOLLO you should first review the instructions in Upgrading ERDAS APOLLO (on page 93).

In This Section
Installation Components ................................................................. 11
Before You Install ........................................................................ 11
Installing and Configuring ERDAS APOLLO Server .................... 23
Installing and Configuring ERDAS APOLLO Server in a Cluster .. 54
Testing Your Installation of ERDAS APOLLO Server ................. 89
Installing ERDAS APOLLO Data Manager................................. 90

Installation Components

ERDAS APOLLO includes the server side components for ERDAS APOLLO Essentials, Advantage, Professional, and Geospatial Portal.

ERDAS APOLLO may only be installed on one of the following Microsoft Windows server operating systems:

- Microsoft Windows Server 2008 R2
- Microsoft Windows Server 2012
- Microsoft Windows Server 2012 R2

See the ERDAS APOLLO Supported Environments document for complete details.

Before You Install

This section lists the tasks you must complete before you install ERDAS APOLLO.

IMPORTANT ERDAS APOLLO is a sophisticated system of software products and modules. Proper installation and configuration is important to ensure that your system runs as expected. While this document will instruct you on the steps you need to take to configure your system, it does not go into detail on how to use the various operating system or database management tools that are required. ERDAS APOLLO system administrators should have some basic understanding of how to configure and maintain a server operating system, web site and database. This includes having familiarity with software tools and utilities such as Windows Server Manager, IIS Manager as well as the database management software used to maintain Oracle, Microsoft SQL Server or PostgreSQL.

If you need help or have question during your installation process Intergraph provides several ways to access information and to contact support, including self-help tools and phone support. See Technical Support and Information for more details.
Antivirus Software Requirements

If you are using antivirus software that features real-time protection and it is scanning your geospatial data files or your ERDAS APOLLO installation folder, it may cause your ERDAS APOLLO system to be unreasonably slow.

For best results, create an "exception rule" that excludes the data files and the installation folder from the scanning of the real-time protection feature.

Installing Windows Identity Foundation (WIF)

Windows Identity Foundation (WIF) is a framework for building identity-aware applications and is a required prerequisite for the Geospatial Portal components that are delivered with ERDAS APOLLO.

If you are installing on Windows Server 2008 R2

To check if WIF is already installed on your server go to Control Panel->Programs->View Installed Updates, and look for Windows Identity Foundation (KB974405) under the Microsoft Windows group.

If WIF is not installed download and install from:

**TIP** Select Windows6.1-KB974405-x64.msu for Windows Server 2008 R2.

If you are installing on Windows Server 2012 or later

You do not need to install WIF as it is included as part of the operating system. You will need to include it in the list of added features when defining the server roles. This will be addressed in Configuring Windows Roles, Role Services and Features (on page 13).
Configuring Windows Server Roles, Role Services and Features

Windows Server uses roles, role services and features as a means to configure the server to perform various functions.

Roles define a collection of related programs that allow the server to perform a specific set of functions. Role services are the programs that provide those specific functions. Features are supplementary programs that contribute to or augment the capabilities of one or more roles.

ERDAS APOLLO Server requires two Windows Server roles: the Application Server role and the Web Server (IIS) role. In addition to these roles, various role services and features must also be added when configuring these two roles.

Server roles, role services and features are defined and configured using Server Manager. Server Manager can be launched from Control Panel > Administrative Tools > Server Manager.

**TIP** If the Application Server and/or Web Server (IIS) roles have already been added to your server, use Server Manager to ensure that all of the necessary role services specified in the steps below are also included.

**TIP** When adding role services, if you are prompted to install additional supporting role services or features, accept the defaults and install the additional role services or features as prompted.

Adding and Configuring the Application Server Role

Use Server Manager to add the Application Server role. In addition to the role services and features selected by default, choose the following role services:

- Web Server (IIS) Support
- Windows Process Activation Service Support
  - HTTP Activation
  - Message Queuing Activation

Adding and Configuring the Web Server (IIS) Role

Use Server Manager to add the Web Server (IIS) Role. In addition to the role services and features selected by default, choose the following role services for the Web Server (IIS) role:

- Web Server > Application Development
  - ISAPI Extensions
  - ISAPI Filters
- Web Server > Common HTTP Features
  - Static Content
**WARNING** Do not enable the Web Server > Common HTTP Features > WebDAV Publishing option. Enabling this feature may cause problems for the ERDAS APOLLO Catalog service.

- Management Tools > IIS 6 Management Compatibility
  - IIS 6 Metabase Compatibility
  - IIS 6 Management Console
  - IIS 6 Scripting Tools
  - IIS 6 WMI Compatibility

### Adding the Windows Identity Foundation 3.5 (WIF) Feature

If you are installing on Windows Server 2012 or later use Server Manager to ensure that the Windows Identity Foundation 3.5 (WIF) feature is installed. If you are installing on Windows Server 2008 R2 refer to *Installing Windows Identity Foundation (WIF)* (on page 12) for details on downloading and installing Windows Identity Foundation.

### Configuring Windows Web Server (IIS)

IIS is the main HTTP Web Server for ERDAS APOLLO. The following components and web applications are deployed within IIS:

- ERDAS APOLLO data management services and OGC Services. These services run in JBoss or Tomcat and are configured with a Tomcat-IIS AJP connector within IIS.

- ERDAS APOLLO Essentials is a web application with ISAPI filters. It is used to stream raster and point cloud data using ECWP and JPIP protocols.

- Geospatial Portal is an ASP.NET MVC3 web application. It accesses the ERDAS APOLLO catalog and data delivery services such as WMS, WCS, WFS, ECWP and JPIP.

- Geospatial Administration Console is also an ASP.NET MVC3 web application. It is used to manage, configure and deploy instances of Geospatial Portal.

### Registering ASP.NET with IIS

**If you are installing on Windows Server 2008 R2**

After you have configured your server with the Web Server (IIS) role, you must register the correct version of ASP.NET with IIS.

1. Open a Command prompt window (Run as Administrator).
2. Navigate to %windir%\Microsoft.NET\Framework64\v4.0.30319.
3. Run the following command: aspnet_regiis -i
4. When the registration completes you can close the command prompt window.

**If you are installing on Windows Server 2012 or later**

On Windows Server 2012 and later the correct version of ASP.NET should already be registered with IIS because of the selections you made when configuring the server roles, role services and features. To verify this, use Server Manager to confirm that ASP.NET 4.5 is listed as a role service in the IIS role.

**Configuring ISAPI and CGI Restrictions**

ISAPI and CGI Restrictions are used to specify which ISAPI and CGI extensions are allowed to run on the Web Server. These restrictions are managed in Internet Information Services (IIS) Manager. ERDAS APOLLO requires that ASP.NET version 4 be allowed.

1. Open **Administrative Tools > Internet Information Services (IIS) Manager**
   
   **TIP** Be sure to run Internet Information Services (IIS) Manager, not Internet Information Services (IIS) 6.0 Manager.

2. In the main pane, double click on the **ISAPI and CGI Restrictions** icon to open the ISAPI and CGI Restrictions view.

3. Set the **Restriction** state of both the 32-bit and 64-bit versions of **ASP.NET v4.0.30310** to **Allowed**.

**Configuring the ERDAS APOLLO Web Site**

**NOTE** Configuring ERDAS APOLLO to use a website other than the "Default Web Site" is optional.

IIS uses a default website to host virtual directories, web applications, web services, and so forth. Typically, ERDAS APOLLO can run using the Default Web Site without any additional configuration of the web site.

For security reasons, some IT administrators may prefer to configure ERDAS APOLLO to use a web site other than the "Default Web Site". If you would like to run ERDAS APOLLO from a web site other than the Default Web Site, follow these steps to add a new web site in IIS.

1. Open **Administrative Tools > Internet Information Services (IIS) Manager**

2. Expand the tree view for the server and select the **Sites** node.

3. Right click on **Sites** and select **Add web site**… from the menu to open the Add Web Site dialog.

4. Enter the desired **Site name**. The **Site name** is a friendly name that will be used in IIS to refer to your web site.

5. Enter a **Physical path** for the site. The **Physical path** is where the content for the site will be stored.

   **NOTE** The physical path for the Default Web Site is typically C:\inetpub\wwwroot.

6. Leave the **IP address** to "All Unassigned" and leave the **Host name** field blank.
Installing and Configuring ERDAS APOLLO

7. Click OK to add the new web site.

8. Copy iisstart.htm and welcome.png from C:\inetpub\wwwroot to the physical path of your new web site.

You are now ready to configure ERDAS APOLLO to use the new web site.

Configuring IIS Logging

In Windows IIS 7 and above, HTTP request logging is enabled by default. Enabling HTTP request logging on a high usage ERDAS APOLLO server can result in consumption of large amounts of disk space and slightly affect performance of ERDAS APOLLO WMS and WFS operations.

**Tip** IIS log files are written to C:\inetpub\logs\LogFiles\W3SVC1.

To disable IIS HTTP request logging:

- Open a command window with administrative privileges and issue the following commands:
  - cd C:\Windows\System32\inetsrv
  - appcmd set config /section:httpLogging /dontLog:True
  - iisreset /restart

To enable IIS HTTP request logging:

- Open a command window with administrative privileges and issue the following commands:
  - cd C:\Windows\System32\inetsrv
  - appcmd set config /section:httpLogging /dontLog:False
  - iisreset /restart

Configuring Secure Sockets Layer (SSL)

By default, ERDAS APOLLO supports HTTP Basic authentication (BA). BA is the simplest access control methodology and provides no encryption or confidentiality protection for user names, passwords, or content data. This may be acceptable if you are not exposing your ERDAS APOLLO website on a public domain.

However, if your ERDAS APOLLO website is on a public domain or if you just want a stronger level of confidentiality in your website transactions, configure your website to use Secure Sockets Layer (SSL). With SSL enabled, ERDAS APOLLO will encrypt passwords and content data.
Before configuring SSL, you will need to obtain a digital certificate from a certificate authority. For more information on SSL best practices and leading global Certificate Authorities visit the Certificate Authority Security Council (CASC) website at https://casecurity.org.

After obtaining a digital certificate follow the steps described in the next sections.

**Importing a Trusted Certificate to the Local Computer**

This section instructs you on how to import a trusted certificate into your Local Computer’s certificate store.

1. Run mmc.exe to launch the Microsoft Management Console (or, open a pre-configured MMC console if you have one.)
   
   **TIP** You should run mmc.exe with Administrator rights.

2. Before you can add certificates to the Windows Certificate Store, you must add the Certificate snap-in to the Microsoft Management Console (MMC) on the Windows Server host on which the View server is installed.

   a. Verify that the MMC and Certificate snap-in are available on the Windows Server computer on which the View server is installed.

   In the MMC window, go to File > Add/Remove Snap-in

   In the Add or Remove Snap-ins window, select Certificates and click Add.

   In the Certificates snap-in window, select Computer account, click Next, select Local computer, and click Finish.

   In the Add or Remove snap-in window, click OK

   1. Expand **Certificates (Local Computer)** to display the certificate store nodes.

   2. Expand **Trusted Root Certification Authorities**, right click on **Certificates** and select All Tasks and **Import**.

   3. On the Certificate Import Wizard Password dialog select **Mark this key as exportable**.

   4. Complete the **Certificate Import Wizard** to import the certificate into the Trusted Root Certification Authorities store

   5. Expand **Intermediate Certification Authorities**, right click on **Certificates** and select All Tasks and **Import**.

   6. Complete the **Certificate Import Wizard** to import the certificate into the Intermediate Certification Authorities store.

**Importing an SSL Certificate into IIS**

This section instructs you on how to import a trusted certificate into IIS.

1. Open Administrative Tools > Internet Information Services (IIS) Manager

2. Click on the server name in the **Connections** pane.

3. In the main pane, double click on the **Server Certificates** icon to open the Server Certificates view.
Installing and Configuring ERDAS APOLLO

4. Click on the Import... link in the far right Actions pane to open the Import Certificate dialog.

5. Select the Certificate File you received from a Certificate Authority and click OK to complete the import.

6. Leave IIS Manager open to complete the next step, Adding an https Binding to the ERDAS APOLLO Web Site (on page 18).

Adding an https Binding to the ERDAS APOLLO Web Site

This section instructs you on how to add an https binding associated with an SSL trusted certificate to your ERDAS APOLLO web site.

1. Open Administrative Tools > Internet Information Services (IIS) Manager.

   **NOTE** If you have just completed Importing an SSL Certificate into IIS (on page 17), IIS Manager should already be opened.

2. Expand the Sites folder

3. Select the site to be secured.

   **TIP** This will either be the Default Web Site or the web site that you added and configured in Configuring the ERDAS APOLLO Web Site (on page 15).

4. From the Actions menu (on the right), select Bindings... to open the Site Bindings dialog box.

5. In the Site Bindings dialog box, click Add... to open the Add Site Binding dialog box.

6. Under Type choose https.

7. The IP address should be the IP address of the site or All Unassigned.

8. The port over which traffic will be secured by SSL is usually 443.

9. The SSL Certificate field should specify the SSL certificate that was imported into IIS in Importing an SSL Certificate into IIS (on page 17).

10. Click OK to add the https binding.

   Your SSL certificate is now installed and the website configured to accept secure connections through https.

Preparing Your Database

ERDAS APOLLO stores and manages the metadata associated with your geospatial content in a database. Supported databases include:

- Oracle®
  - Oracle Database 11g, Standard or Enterprise Edition
  - Oracle Database 12c, Standard or Enterprise Edition
- Microsoft SQL Server®
Installing and Configuring ERDAS APOLLO

- Microsoft SQL Server 2012 Express or Standard or Enterprise Edition (Express Edition should be used for testing & development purposes only)
- Microsoft SQL Server 2014 Express or Standard or Enterprise Edition (Express Edition should be used for testing & development purposes only)
- PostgreSQL version 9 or higher (with PostGIS 2.0 extension)

**CAUTION** Complete documentation for installing, configuring and maintaining a database in Oracle, Microsoft SQL Server or PostgreSQL is well beyond the scope of this text. The following instructions are intended to help you create a new ERDAS APOLLO catalog database and make decisions on configuring it to work with ERDAS APOLLO. Any database configuration decisions should be made in the context of your site’s database IT policies.

The ERDAS APOLLO Server Configuration Wizard will do most of the work needed to create and configure the tables and other database artifacts needed by ERDAS APOLLO. However, some manual preparation is required. Follow the instructions in one of the following sections, depending on which database you are using, to prepare your database before running the ERDAS APOLLO Setup and Configuration Wizard.

**Preparing Oracle for ERDAS APOLLO Configuration**

This section includes instructions for preparing Oracle to be configured with an ERDAS APOLLO catalog. If you are using Microsoft SQL Server or PostgreSQL, skip this section.

To prepare Oracle you need to add an Oracle user that will be used by the ERDAS APOLLO Server Configuration Wizard to connect to Oracle. The Oracle user requires resource, connect and create view rights. Use the following sqlplus commands to create a new user with the required rights:

```
CREATE USER [user name] IDENTIFIED BY [password];
GRANT RESOURCE, CONNECT, CREATE VIEW TO [user name];
```

**Preventing Microsoft SQL Server for ERDAS APOLLO Configuration**

This section includes instructions for preparing Microsoft SQL Server to be configured with an ERDAS APOLLO catalog. If you are using Oracle or PostgreSQL, skip this section.

**Create a New Database and SQL Server Login**

To prepare Microsoft SQL Server you need to create a new database and create or designate a SQL Server login that will be used by the ERDAS APOLLO Server Configuration Wizard to connect to SQL Server.

**IMPORTANT** ERDAS APOLLO requires SQL Server authentication. If your installation of SQL Server is configured for **Windows Authentication mode** only, you will need to change it to **SQL Server and Windows Authentication mode**. Consult your Microsoft SQL Server
Installing and Configuring ERDAS APOLLO

documentation or visit http://msdn.microsoft.com/en-us/library/ms188670.aspx for details on how to change the Server Authentication mode.

1. Create a new SQL Server login. You will use this login to connect to the ERDAS APOLLO catalog database.
   
   **CAUTION** Do not include a dollar sign ($) in the login password.

2. Create a new SQL Server database. The ERDAS APOLLO Server Configuration Wizard will populate this database to create an ERDAS APOLLO catalog.

3. Map the SQL Server login in step 1 to the db_owner role of the database created in step 2.

Enable and Configure TCP/IP

ERDAS APOLLO communicates with SQL Server via the TCP/IP protocol. You must enable TCP/IP and configure it to communicate on a static port.

1. Open the SQL Server Configuration Manager.

2. In the left pane, expand SQL Server Network Configuration and select the Protocols item for the SQL Server instance that you are using.

3. Double click the TCP/IP protocol in the right pane to open the TCP/IP Properties dialog.

4. On the Protocol tab, set the value for **Enabled** to **Yes**.

5. Switch to the **IP Addresses** tab.

6. Scroll down to the **IP All** section.

7. Set **TCP Dynamic Ports** to be blank.

8. Set **TCP Port** to **1433**.
   
   **NOTE** 1433 is the default port number used to connect to SQL Server via TCP/IP. If desired, you can use a different port number. You will need to provide the port number as part of the connection information when you run the ERDAS APOLLO Server Configuration Wizard.


10. Select SQL Server Services in the left pane.

11. In the right pane right click on the SQL Server service corresponding to the instance you are using and select Restart.

Preparing PostgreSQL for ERDAS APOLLO Configuration

This section includes instructions for preparing PostgreSQL to be configured with an ERDAS APOLLO catalog. If you are using Oracle or Microsoft SQL Server, skip this section.

To prepare PostgreSQL you need to create a new PostGIS database and create or designate a login role that will be used by the ERDAS APOLLO Server Configuration Wizard to connect to PostgreSQL.
1. Create a new PostgreSQL login role. You will use this login role to connect to the ERDAS APOLLO catalog database.

   **CAUTION** Do not include a dollar sign ($) in the login role password.

2. Create a new PostGIS database. Use either a PostGIS template or an existing PostGIS database as the template for the new database. The ERDAS APOLLO Server Configuration Wizard will populate this database to create an ERDAS APOLLO catalog.

   **IMPORTANT** Make sure the login role from step 1 has permissions to create database objects in the new database.

**ERDAS Foundation**

ERDAS Foundation is a bundle of components which are shared by multiple ERDAS-branded products. This includes providing support for EGM 2008 (Earth Gravitational Model) geodetic datum in all ERDAS vertical-datum-aware products. Rather than require you to download multiple, redundant copies of this large datum (and other capabilities) for each product you install, ERDAS Foundation is a uniform, prerequisite installer that delivers a single copy of EGM 2008 and several other large files used across the ERDAS product lines.

**Prerequisite to Installing ERDAS Products**

Before you can install certain ERDAS products, the current version of ERDAS Foundation must be installed. After the Foundation is installed on a system, any number of ERDAS products may then be installed on the same system using a single installation of ERDAS Foundation.

- ERDAS Foundation installation must precede installation of products that rely upon it.
- The ERDAS Foundation is fundamentally a set of datum files, and thus the same Foundation can be used by 32-bit or 64-bit applications.
- Only one copy of the ERDAS Foundation can be installed on any system. The latest version of ERDAS Foundation will support current products, and any earlier releases of products that depend upon the Foundation.
- You must not remove (uninstall) the ERDAS Foundation before you have removed all ERDAS products that rely upon it.
- If you install from a product DVD and Foundation is required then Foundation is installed automatically. If you download a zip file and install, then you need to install the ERDAS Foundation separately.

**ERDAS Products that Requires the ERDAS Foundation**

ERDAS products that requires prior installation of the ERDAS Foundation:

- ERDAS IMAGINE
- ER Mapper (installed with ERDAS IMAGINE so ERDAS Foundation must be installed also)
Exceptions
Some ERDAS products do not require prior installation of ERDAS Foundation:
- ERDAS APOLLO Essentials, Advantage, Professional
- ERDAS APOLLO Data Manager
- Condor for ERDAS
- ERDAS Extensions for ArcGIS
- ECW JPEG2000 SDK
- Example Data
- ORIMA
- PRO600

Included in Foundation Installer
The ERDAS Foundation installer includes:
- EGM 2008 geodetic datum
- Other sizable geodetic datums used to perform coordinate transformations
- Intergraph Licensing 11.11.1 application
- Microsoft Runtime libraries (for example, MSVCRT) required by applications

Installing the ERDAS Foundation
1. Expand the Supporting Software section on the Hexagon Geospatial Setup Manager utility and select ERDAS Foundation 2015.
2. In the Action column of the New Software section select Install.
   [TIP] If you see the Installed Software and Configuration sections instead of the New Software section after you select ERDAS Foundation 2015, ERDAS Foundation 2015 has already been installed.
3. Follow the instructions in the wizard to complete the installation.

Licensing ERDAS APOLLO
Intergraph Licensing delivers the necessary files for a product to take full advantage of licensing functionality: License Administration to configure and query license servers, License Borrowing to simplify license borrowing, and a License Host ID utility that displays composite, Amazon, and hardware key host IDs.
Installing and Configuring ERDAS APOLLO

**TIP** The Intergraph Licensing 11.11.1 application is automatically installed when you install ERDAS Foundation.

**Installing Intergraph Licensing 11.11.1**

1. Expand the Supporting Software section on the Hexagon Geospatial Setup Manager utility and select **Intergraph Licensing 11.11.1**.

2. In the **Action** column of the **New Software** section select **Install**.

   **TIP** If you see the **Installed Software** and **Configuration** sections instead of the **New Software** section after you select Intergraph Licensing 11.11.1, Intergraph Licensing 11.11.1 has already been installed.

3. Follow the instructions in the wizard to complete Intergraph Licensing 11.11.1 installation.

**Connecting to a License Server**

Run the license utility (run as Administrator) to define a license source for ERDAS APOLLO Server. The license source is a connection to a license server. Refer to the Intergraph License Administration utility online documentation for more information about acquiring a product license and configuring a license server.

**TIP** Define your ERDAS APOLLO license before you install and configure ERDAS APOLLO Server.

**Installing and Configuring ERDAS APOLLO Server**

This section describes how to install and configure ERDAS APOLLO Server. If you are installing ERDAS APOLLO Server on a single node (non-clustered) follow the instructions in this section without variation.

If you are installing ERDAS APOLLO Server in a clustered configuration, this section still provides the basic instructions for installing ERDAS APOLLO Server on each node, however there are some variations in configuration, depending on the type of node being configured. Refer to **Installing and Configuring ERDAS APOLLO Server in a Cluster** (on page 54) for details and variations in the procedure.

**TIP** Make sure the World Wide Web Publishing Service and the IIS Admin Service are running before you install ERDAS APOLLO Server.

**Installing ERDAS APOLLO Server**

This installation program installs the ERDAS APOLLO Server files for all three tiers of ERDAS APOLLO: Essentials, Advantage, and Professional. You will only be able to run the tier for which you have a valid license.

**NOTE** Installing only copies the ERDAS APOLLO Server files to your computer. After installing, run the **Configuration Wizard** (see "Configure Server" on page 32) to configure your instance of ERDAS APOLLO Server.
You must complete all the steps described in Before You Install (on page 11) before installing ERDAS APOLLO Server.

1. Insert the Hexagon Geospatial Software DVD and the Setup Manager dialog opens. Expand the ERDAS APOLLO 2015 node and then select the ERDAS APOLLO 2015 to install.

2. In the New Software section, click Install. Several preparatory dialogs display before the Welcome dialog opens.
NOTE The last three digits of the version number in title may not match those in the figures.
Click **Next** and the License Agreement dialog opens. You can print the License Agreement. Read the agreement and then select I Accept the terms of the License Agreement.
1. Click **Next** and the Custom Setup dialog opens

![Custom Setup Dialog]

The following actions may be performed:

- Click the down arrow to select which feature to install.
- Click **Change...** to change the install location.
- Click **Space** to see the required disk space for the ERDAS APOLLO Server installation and the available disk space on your computer.
2. Click **Next** and the Ready to Install the Program dialog opens.

3. Click **Install** and the Installing ERDAS APOLLO 2015 dialog shows the progress of the installation.
If the Files in Use dialog opens, select **Automatically close and attempt to restart applications**.
When the installation is complete the Completed dialog opens.

4. Click **Finish** and the Setup Manager shows the Configure option for the server in the Configuration section of the dialog. See  Configuring ERDAS APOLLO Server (on page 32) to continue with the configuration of your server.

**Installed Folders**

This section describes all the folders created by the ERDAS APOLLO Server installer. As described in Installing ERDAS APOLLO Server (on page 23) the installer will request a folder to install ERDAS APOLLO Server. By convention, this folder is referred to as `<APOLLO_HOME>` in all the documentation. The default location for `<APOLLO_HOME>` is `C:\Program Files\Hexagon\ERDAS APOLLO`, but it can be changed during the installation process.

After the installation, `<APOLLO_HOME>` contains the following folders.

- `bin` - Contains product binaries.
- `cache` - Contains the temporary cache files for each of the web services (map, vector and coverage).
- `config` - Contains the map, vector, coverage, and catalog servlets resources: configuration files, portrayal styles, ISO metadata files, legend icons are among the files needed for a service to be properly exposed. A "storage" subfolder holds data files produced by the services themselves or uploaded as part of the service configuration.
Installing and Configuring ERDAS APOLLO

configwizard - Contains the configuration wizard files which make the installer unique for the ERDAS APOLLO server.

data - Contains sample data for a set of predefined services, and constitutes a placeholder for custom data: images, Shapefiles, coverages, imagery, and so forth.

Decoding service - Contains an IIS service used to control vector data decoding.

doc - Contains the product documentation in HTML.

indexes - Contains some of the search indexes that ERDAS APOLLO catalog generates for faster searches

ISAPI - Information needed to direct ERDAS APOLLO server requests from IIS to JBoss.

jboss - Contains the preconfigured Jboss 7.1.1 Application Server

lib - Content for ERDAS APOLLO Essentials.

log - The log folder is a placeholder for various servlet and web application log files. Log files are prefixed with their component IDs, namely "map" for WMS, "vector" for WFS, "coverage" for WCS, "vectorIndexer" for the Coverage Indexing WFS and "catalog" for the Catalog Service. ERDAS APOLLO Server uses a rolling mechanism to manage the log file, so that each component produces files suffixed by a number between 0 and 9.

Support may request these files be sent if customers experience problems with the ERDAS APOLLO Server.

server - Content for ERDAS APOLLO Essentials.

storage - Contains all the data files and temporary files that are created by various services

tomcat – Contains the preconfigured Tomcat 7.0.53 application server.

tools - Contains the tools described in the Tools and Viewers section of the ERDAS APOLLO Server User Guide, including the ERDAS APOLLO Style Editor and the Schema Generator. It also contains Apache Ant binaries used by the installer to build the servers deployable files.

The bundled Java JDK is also installed here. It contains the following Raster SDK resources used by the GIO decoders.

- GIO decoder configuration of the RDS processes executed to actually decode the data
- various libraries used for those tools
- build scripts used to build the config folder content and the webapps

webapps - Contains the server portal erdas-apollo. This folder is used to build the various war files that will be copied to the dist folder.

build.xml - This build file is an Ant script that can be used to rebuild the web applications.

cache - Contains the temporary cache files for each of the web services (map, vector, and coverage).

**WARNING** It is important to understand that the installer first creates the erdas-apollo directory, configures the applications, and then builds the WAR files from this directory.
Installing and Configuring ERDAS APOLLO

**TIP** You may have to change permissions on some installation folders (typically folders where log files or config files are stored), if the Application Server used to deploy the ERDAS APOLLO Server component is not started with the same OS user than the one used to install the product. The user running the Application Server must have read/write access to installation folders.

Configuring ERDAS APOLLO Server

**Import Previous Configuration Parameters**

If you have an UpdateSelectedProperties.txt file that was generated by running SaveProperties.bat on a previous version of ERDAS APOLLO, copy that file to your new <APOLLO_HOME> folder. The parameters and parameter values contained in this file will be automatically imported when you run the Configuration Wizard in the next steps.

For more information on migrating existing parameters from a previous version of ERDAS APOLLO see *Migrating Customized Properties to ERDAS APOLLO 2015* (on page 97).

**Configure Server**

The Configuration wizard lets you set IIS parameters, define the catalog database connection, define a SMTP server connection, set default locations for user data, and so forth.
1. After completing the installation procedure outlined above, the Setup Manager shows the Configure option for the server in the Configuration section of the dialog:
2. From the Setup Manager dialog, click **Configure** and the ERDAS APOLLO Server Configuration Wizard dialog opens.

3. Click **Next** and the Install missing features dialog opens. This dialog shows a green check for features that are enabled and a red X beside any features that still need to be installed. Click **Configure features** if there are any red Xs. Review *Before You Install* (on page 11) for details on configuring prerequisite components. After configuring, select the missing features click **Refresh** and the **Next** button becomes active.
Installing and Configuring ERDAS APOLLO

![ERDAS APOLLO Server Configuration Wizard](image)

**Install missing features**
Please install any missing features to continue

<table>
<thead>
<tr>
<th>Feature name</th>
<th>Is enabled?</th>
</tr>
</thead>
<tbody>
<tr>
<td>IIS-ISAPIFilter</td>
<td>✔</td>
</tr>
<tr>
<td>IIS-ISAPIExtensions</td>
<td>✔</td>
</tr>
<tr>
<td>IIS-StaticContent</td>
<td>✔</td>
</tr>
<tr>
<td>IIS-WebServerRole</td>
<td></td>
</tr>
<tr>
<td>IIS-Metabase</td>
<td></td>
</tr>
<tr>
<td>IIS-WindowsAuthentication</td>
<td></td>
</tr>
<tr>
<td>IIS-ASPIET</td>
<td></td>
</tr>
<tr>
<td>WCF-HTTP-Activation</td>
<td></td>
</tr>
<tr>
<td>MSMQ-Server</td>
<td></td>
</tr>
</tbody>
</table>

Configure features  Refresh

< Back  Next >  Cancel

35
4. Click **Next** and the Select web site dialog opens. This dialog may take a few minutes to open since it is gathering information from your system. This shows the web sites defined for your server through IIS. At a minimum you see the "Default Web Site" created when you installed IIS.

Select the web site where ERDAS APOLLO will be installed.

Check **Configure Web Site for JPIP Compatibility** to configure JPIP streaming for the website that handles all the web applications. Click **Next** to continue.
5. Configure the web site where you want to install the Administration Console. The default is Default Web Site. You may also change the application name of the Administration Console.
6. Click **Next** and the Select Install Type dialog opens.

To configure a single instance of ERDAS APOLLO, take the default **Standalone** option. If you are creating a cluster configuration, select **New cluster** to install to the first node of the cluster, or select **Add to existing cluster** if you are configuring additional cluster nodes.

**REFERENCE** Refer to *Configuring ERDAS APOLLO in a Cluster* (see “Installing and Configuring ERDAS APOLLO Server in a Cluster” on page 54) to learn more about cluster configuration options.
7. Click **Next** to display the Choose Credentials dialog.

- Choose **Default** if you want to use the default credentials for the account that APOLLO application pools and Windows services will run under.
- If you are updating an existing configuration, choosing **Current** preserves the existing selection.
- Choose **Custom** to enter credentials for the account of your choice. Use this option if you will need to access shared network resources.
8. Click **Next** to open the Select Application Server dialog.

You may choose either JBoss or Tomcat to host the applications.
9. Click **Next** and the Catalog Database Connection dialog opens.

Configure the connection parameters for the catalog database:

**Database type** - one of the following:
- Oracle
- Postgres
- SQL Server

**Server** - server where the database is located

**TIP** If your SQL Server database resides on the same server that ERDAS APOLLO is configured on, you may use the actual server name or `(local)` – parentheses required. However, if the database resides in the default instance you must specify `(local)`.

**Port** - listener port number

**SID** (Oracle only) - name of the database

**Database name** (SQL Server or Postgres) - name of the database

**Username** - database user name
Installing and Configuring ERDAS APOLLO

**Password** - password for the database user name

**Database instance** - (optional, for SQL Server Only) the SQL server database instance name

**IMPORTANT** If your database resides in the default instance of SQL Server, leave the Database instance blank. Otherwise use the actual instance name.

10. Click **Next** and the wizard verifies the database and the user, and then the HTTP Server Settings dialog opens.

Enter the internet connection information for the server.

**Hostname** - Name of the computer on which you are installing ERDAS APOLLO Server or the static IP address of that computer.

**TIP** If you are setting up an internet site or configuring an SSL secured site using a domain level SSL certificate:

- *Enter the full domain name, such as www.MyAPOLLO.com.*

If you are setting up an Amazon Web Service (AWS) instance:

![ERDAS APOLLO Server Configuration Wizard](image)
• Make sure that the AWS instance that is the license server has an elastic IP.
• Set the host name for the ERDAS APOLLO server to the public DNS name of the server.

**Protocol** - You select the port numbers for HTTP and HTTPS when you set up IIS. Select the protocol and port number for the bindings to use for your internet connection.

**TIP** See the SSL Configuration section in the ERDAS APOLLO Administrator Guide for details on a SSL connection. This is only available if the selected website has a binding for HTTPS. If it does, then the HTTPS option is selected by default.

11. Click **Next** and SMTP Settings dialog opens.

The Simple Mail Transfer Protocol (SMTP) is required to define the location to send e-mails.

- **Host** computer name that will send e-mail
- **Port** SMTP port on the host
- **Username** valid username for the host computer
- **Password** valid password for the username of the host computer
- **Authorization**
installing and configuring erdas apollo

- **None** - no security
- **TLS** - Transport Layer Security
- **SSL** - Secure Sockets Layer (SSL) protocol

Windows Firewall and other antivirus programs may block outgoing e-mail. Add your application server to the list of applications allowed to send e-mail from the server.

12. Click **Next** and the Custom Paths dialog opens.

![Custom Paths dialog](image)

Click the **Configure custom locations** checkbox to modify any of the default paths. To change a path, click and highlight the row you want to change and then click **Browse...** to browse to and select a different location for any of the files or the WPS output.

**IMPORTANT** We recommend that you change all of the default paths so that they are not in the default ERDAS APOLLO delivery folder. This ensures that your user data is not deleted when you uninstall older versions of ERDAS APOLLO.
13. Click **Next** to display the OpenStreetMap configuration dialog.

You may elect to use OpenStreetMap as the default provider of background map tiles after reviewing the usage policy. Choose **No** if you intend to provide your own custom background map for your web portal.
14. Click **Next** and the Summary dialog opens.

Review the summary and click **Finish** when ready.
15. The Configuring your application dialog opens. The configuration process takes several minutes. Several messages display during configuration.
When the configuration process completes the Finished dialog opens.

The Finished dialog indicates the process has completed.

Scroll the list of messages to verify that the configuration completed successfully. A log file notes all the steps taken to configure this instance of ERDAS APOLLO Server. Click Open Log File to view the log.

16. Click Close to exit. The Setup Manager now shows the Modify, repair, or remove option for the server.
Application Pools and Worker Processes

- ERDAS APOLLO Essentials, Geospatial Portal, and Administration Console are using native worker processes.
- ERDAS APOLLO Essentials creates its own application pool when it is installed.
- ERDAS APOLLO Advantage is using the ERDAS APOLLO Essentials pool for the JBoss applications.
- ERDAS APOLLO Advantage JBoss is configured to run as a worker instance and is not managed by IIS WAS (Windows Process Activation Service).
- ERDAS APOLLO JBoss is configured via Redirector (mod_jk) ISAPI filter by one of the IIS Worker Processes.
- One of the ERDAS APOLLO Essentials worker processes is handling the redirection.

Configure to Access Remote Data Sources

**NOTE** The ERDAS APOLLO Configuration Wizard allows you to specify a user for all ERDAS APOLLO application pools and Windows services. If you need a finer grained level of control, this section explains how to assign users to specific application pools or Windows services.

If you are using a mapped network drive for crawling, your application server must run as a user that has access to the network share. Otherwise, the mapped network drive will not appear as one of the drives available for browsing in the ERDAS APOLLO Data Manager Browse dialog.

UNC paths are a preferred alternative to mapped network drives. If you are accessing network resources from a UNC path, you will also need to define a qualified user for the JBoss or Tomcat application server as well as several of the IIS AppPools.

The application server (JBoss or Tomcat) must have access to data on shared drives used by ERDAS APOLLO. This is accomplished by setting the user account of the application server to a user that has been granted privileges to access the shared drives.

Follow these directions to specify a user for the application server:

1. Open the Microsoft Windows Services utility.
   - **TIP** You can find the Services utility in the Administrative Tools section of the Windows Start menu or Start screen.
2. If you are using JBoss as your application server select **ERDAS APOLLO JBoss Application Server 7.1.1**.
Installing and Configuring ERDAS APOLLO

If you are using Tomcat as your application server select **ERDAS APOLLO Tomcat Application Server**.

3. Right click on the selected service and select **Properties**

4. Select the **Log On** tab and click the **This account** radio button.

Enter or browse to the user account that has access to the data on the shared drive.

The qualified user should also be used for the identity of these IIS AppPools.

- FgdbServiceAppPool
- DecodingServiceAppPool
- ApolloCatalogWMSAppPool
- ApolloCatalogWMSPublicAppPool
- ERDAS APOLLO Essentials

Use IIS Manager to set the AppPool identities using the following steps to set it to build an account such as Network Service or a custom account with a specific Windows domain user for the application to get access to the files on the network shares.

Expand the tree view of IIS manager and select the AppPool from the above list then choose **Advanced settings > Identity > ApplicationPoolIdentity** then click on the ellipse button.

- For **built-in account**, select the **LocalSystem** or **NetworkService** from the drop-down.

- For a **custom account**, click set, then enter the domain/user and password for the same account that you set for the application server.

**NOTE** If these AppPools are already running, use Task Manager to stop them so they restart with the correct identity. The AppPools will restart automatically as needed.
After you have set the specified user for the ApplicationPoolIdentity for the AppPools listed above, specify that user for the Anonymous Authentication of the related web applications by doing the following steps.

1. Expand the tree view of IIS Manager and click on the desired web application.
   a. In the Features View, double-click on the Authentication feature.
   b. Select Anonymous Authentication from the list, then click Edit… in the Actions menu.
   c. On the Edit Anonymous Authentication Credentials dialog, select the radio button for Application pool identity. Click OK to save and dismiss.

Repeat this workflow for the following web applications:
- ApolloCatalogWMS
- ApolloCatalogWMSPublic
- DecodingService
- ecwp
- erdas-iws
- FgdbService

After you have edited the applicable web applications, you will need to restart IIS.

1. Select the server node name in the IIS Manager tree view.
   a. From the Actions menu, select Stop and wait for the IIS service to completely stop.
   b. Select Start to restart the IIS service.

Image Files on a Remote Windows Server or NAS

You can configure your ERDAS APOLLO Essentials so that users can access datasets from virtual directories that are mapped to network shares from other Windows servers. This is done the same way as with local directories (outlined above) but extra configuration may be required to ensure that ERDAS APOLLO Essentials has the necessary permission to access these files.

ERDAS APOLLO Essentials impersonates the user that is configured as the anonymous user for the /ecwp/ and /erdas-iws/ virtual directories when it accesses files. By default this is the Internet Guest Account. As this is a local system user, it does not have permissions to access files located on network shares. This user will need to be changed to a domain level user that has permission to access all files that you are going to share with ERDAS APOLLO Essentials.

If you are using a mapped network drive for crawling, you must run your application server (JBoss or Tomcat) with the same user who has access to the network share. Otherwise, the mapped network drive will not appear as one of the drives available for browsing in the ERDAS APOLLO Data Manager Browse dialog.
UNC paths are a much preferred alternative to mapped network drives. If you are accessing network resources from a UNC path, you will also need to define a qualified user for your application server and several of the IIS AppPools.

Establishing the necessary credentials for the application server and select IIS AppPools is easily accomplished using the Configuration Wizard. The "Choose credentials" pane of the Configuration Wizard allows you to specify the user name and password of the authenticated user that has access to the shared resources from which you will access data. If you failed to specify this user when you initially ran the Configuration Wizard, you may simply run the wizard again to update the credentials.

Configuring APOLLO Services for SSL

If you have configured Secure Sockets Layer as described in Configuring Secure Sockets Layer (SSL) (on page 16), you can now configure your ERDAS APOLLO services to use https and SSL.

Configuring the APOLLO Catalog WMS Service for SSL
1. Navigate to C:\Program Files\Common Files\Hexagon\Services\Instances\ApolloCatalogWMS.
2. Open web.config and search for the comment, "If you wish to run the service over HTTPS transport change the mode from None to Transport".
3. On the next line change <security mode="None"> to <security mode="Transport">.
4. Search for the comment again and change the second occurrence from "None" to "Transport" also.
5. Save and close the file. The ERDAS APOLLO Catalog WMS service will automatically restart.

Configuring the FGDB Service URL for SSL

The ERDAS APOLLO FGDB service can be configured to be accessed via localhost if port 80 will remain open on the server. However, as part of your SSL configuration, you may have decided to close port 80 for security reasons.

If port 80 will remain open, perform the following steps:
1. Run regedit.exe.
2. Navigate to:
   HKEY_LOCAL_MACHINE\SOFTWARE\Intergraph\FgdbService\FGDBServiceUrl
   This key contains the address of the service used to process FGDB data.
3. Change the value of the FGDBServiceUrl key to remove the port 443 specifier. The following shows an example.
http://localhost/FgdbService/fgdbacrossorbservice.svc/fgdbacessor

4. In IIS Manager restart IIS.

If port 80 is closed, perform the following steps:

1. Run regedit.exe.

2. Navigate to 
   HKEY_LOCAL_MACHINE\SOFTWARE\Intergraph\FgdbService\FGDBServiceUrl.
   This key contains the address of the service used to process FGDB data.

3. Change the value of the FGDBServiceUrl key to include https scheme, server name, and
   the port 443 specifier. Be sure to use the fully qualified domain name of the server and
   SSL port:
   https://yourserver.yourdomain.com:443/FgdbService/fgdbacrossorservice.svc/fgdbacessor

4. Next, the transport layers to the FGDB service must be changed to use HTTPS. Perform
   the following edits:
   a. Open <APOLLO HOME>\DecodingService\web.config
      i. Change httpTransport to httpsTransport
   b. Open C:\Program Files/Common
      Files\Hexagon\Services\Instances\ApolloCatalogWMS\web.config
      i. Change httpTransport to httpsTransport
   c. Open C:\Program Files\Common
      Files\Hexagon\Services\Instances\ApolloCatalogWMSPublic\web.config
      i. Change httpTransport to httpsTransport
   d. Open C:\Program Files\Common
      Files\Intergraph\Geoprocessing\3.0\FgdbService\web.config
      i. Change httpTransport to httpsTransport

5. In IIS Manager restart IIS.

Configure Geospatial Portal for SSL

If IIS is configured to receive requests on a public address and that address is not resolved as
the localhost IP (it is IP address of another server that redirects requests), configure the host
machine to resolve the public host name as the localhost IP address.

To configure the host machine, add the following line to
C:\Windows\System32\drivers\etc\hosts file.
127.0.0.1 publichostname.yourdomain.com
Installing and Configuring ERDAS APOLLO Server in a Cluster

ERDAS APOLLO provides high performance with a large number of users, but you can also increase the performance and scalability by creating a cluster configuration. The servers in this cluster share the incoming requests from the client users so that your system can handle a higher user volume. Clients include: ERDAS APOLLO Data Manager, Geospatial Portal, ERDAS APOLLO Catalog Web Interface, and exposed WMS, WMTS, and ECWP services.

A cluster consists of linked computers, each possibly serving a specific function and sharing the computational load of processing to improve performance and availability as compared to using a single computer. Clustering is highly configurable and depends on your available hardware. This section gives one example of a cluster setup; describing all possible configurations is outside the scope of this document.

The workhorses of the cluster are the servers, each installed with ERDAS APOLLO. All servers are connected to the same catalog database and shared configuration. You can have an unlimited number of server nodes in a cluster.

The cluster of servers interacts with the clients through a load balancer.
Refer to the following diagram for an overview of a cluster configuration.
Installing and Configuring ERDAS APOLLO
Cluster Installation and Configuration

You install ERDAS APOLLO Advantage/Professional on each cluster node, beginning with the primary cluster node. Installation will be the same on each cluster node, but configuration using the Configuration Wizard will vary slightly between the first cluster node and any subsequently added nodes.

Set up the first node in the Cluster

Follow these instructions to set up the first node in the cluster. Refer to the full instructions in *Installing and Configuring ERDAS APOLLO Server* (on page 23) for typical standalone installation and configuration, and the specific details for the cluster here.

1. **Destination web site**
Select the site/port to install ERDAS APOLLO. If you are using this node as the entry point for the cluster, which is the load balancer node, you will need to install ERDAS APOLLO on a separate site/port than the cluster's entry point. For example, users may access the cluster on port 80, while in turn the load balancer will access the ERDAS APOLLO instance on port 81 of the same server node. In this example, a separate site has been created for the ERDAS APOLLO cluster node. The entry address into the cluster, the load balancer, will be the Default Web Site (usually configured as port 80).

2. **Install Type**
Set the first node installed in the cluster to **New cluster**.

3. **Shared Configuration Folder**
All nodes in the cluster will share configuration. Be sure that your administrator sets up a file share that is accessible from all nodes, then enter that share in the **Folder** field.

4. **Catalog Database Connection**
When configuring the catalog database for each node in the cluster, make sure that all nodes point to the same catalog instance.

5. **Cluster Settings**

Specify the cluster settings for the load balancer node, aggregated logging and intra-cluster communication. Take the defaults if you are not sure.

**Load balancer host and port** - The entry point into the cluster is the load balancer and this node and its port should not be the same as any of the ERDAS APOLLO server nodes in the cluster.

**Cluster multicast address** - The default cluster multicast address is 230.0.0.1. Use the default address unless you are installing multiple clusters on your network. If you have multiple clusters, make sure each cluster has a unique multicast IP address. The multicast address is used in two places.

- Used to synchronize the nodes in the cluster (for JBoss it is in standalone.xml) used by Jgroups configuration of JBoss cluster setup.
- Used by distributed ehcache, which is used for both Hibernate second level cache and the configuration setup.
This information tells each ERDAS APOLLO Server node how to connect to the cluster. Use the same Address, Host, and Port each time you run the installer to set up another node.

**Syslog daemon host** - URL of the tool (syslog daemon) that consolidates the logs from all nodes (default is localhost). This tool simplifies troubleshooting.

**Syslog daemon port** - port number of the syslog daemon that consolidates the logs from all nodes. (default is 514)
Set up all subsequent nodes in the Cluster

Once you install ERDAS APOLLO on the first node in the cluster, install ERDAS APOLLO on all of the other cluster nodes using the following instructions.

1. **Destination Web Site**

   Cluster nodes can be installed on any site/port. In this example, we are installing on the Default Web Site (on port 80). Make a note of the port on which you have installed the server on each cluster node. You will need the port number when you configure the load balancer later.

   ![ERDAS APOLLO Server Configuration Wizard](image)

   **Select web site**
   Select destination web site where ERDAS APOLLO Essentials 2015 will be installed

   - W3SVC1 (Default Web Site)

   - Configure Web Site for JPIP Compatibility

2. **Install Type**
Installing and Configuring ERDAS APOLLO

On the Select Install Type dialog, select **Add to existing cluster**. Do this for all subsequent nodes after you set up the **New cluster**.

3. **Shared Configuration Folder**
Specify the location where this node will access the configuration files shared with the cluster. This is the same location that you specified for the **New cluster** node.

4. **Catalog Database Connection**
On the Catalog Database Connection dialog, make sure that all nodes in the cluster point to the same catalog database instance.

![ERDAS APOLLO Server Configuration Wizard](image)

The wizard will automatically configure your server to access the database specified below.

- **Database type**: Postgres
- **Server**: APOLLO_DB_SERVER
- **Port**: 5432
- **Database name**: apollocatalog
- **Username**: apolloadmin
- **Password**: ********

5. **Cluster Settings**

   Specify the cluster settings for the load balancer, aggregated logging and intra-cluster communication.

   **Load balancer host and port** - The entry point into the cluster is the load balancer and this node and its port should not be the same as any of the ERDAS APOLLO server nodes in the cluster.

   **Cluster multicast address** - The default cluster multicast address is 230.0.0.1. Use the default address unless you are installing multiple clusters on your network. If you have multiple clusters, make sure each cluster has a unique multicast IP address. The multicast address is used in two places:

   - Used to synchronize the nodes in the cluster (for JBoss it is in standalone.xml) used by JGroups configuration of JBoss cluster setup.
   - Used by distributed ehcache, which is used for both Hibernate second level cache and the configuration setup.
This information tells each ERDAS APOLLO Server node how to connect to the cluster. Use the same Address, Host, and Port each time you run the installer to set up another node.

**Syslog daemon host** - URL of the tool (syslog daemon) that consolidates the logs from all nodes (default is localhost). This tool simplifies troubleshooting.

**Syslog daemon port** - port number of the syslog daemon that consolidates the logs from all nodes. (default is 514)
Configure Subcomponents for the Cluster

Several subcomponents within ERDAS APOLLO Advantage / Professional need to be manually configured for clustering.

SDI Services (WMS)

SDI Services instances are typical ASP.NET web services. Unlike a web application, they don't have session state so concerns about shared session state and client affinity are not an issue. However, in the ERDAS APOLLO Advantage / Professional WMS instances, there is some behind-the-scenes caching. WMS requests invoked from Geospatial Portal (the main client) will not be load balanced. In other words, when a user begins a Geospatial Portal session, WMS requests from that user, during that session, will be serviced by the same cluster node. This allows us the benefits of the caching that is happening in the WMS service.

Most of the configuration for deployed SDI Services is specific to each cluster node. Most of the configuration will be done through the Geospatial Server Administration Console (Admin Console) on each node. Some configuration is not exposed via the Admin Console and must be done by editing the Web.config directly. This has to be done independently on every node in the cluster.

The CRSStore is the exception. The directory containing all CRS configuration and files can be shared among instances on a cluster node and across cluster nodes.

For APOLLO Advantage / Professional WMS services, the administrator can change the directory pointed by the registry key:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Intergraph\Geospatial Server\CommonCSFStorePath
```

to a shared directory accessible by all nodes. See Geospatial Server Administration Console (on page 68).

Geospatial Server Administration Console

Since the Geospatial Server Administration Console (Admin Console) is not cluster aware, changes to Geospatial Portal and/or SDI service instances need to be made independently on each node in the cluster.

**NOTE** Accessing the Admin Console via the cluster front-end address will be disallowed.

Provisioning Service (Clip-Zip-Ship)

If you wish to have a common location for Clip-Zip-Ship files you will need to do the following on each node in your cluster.

1. In the shared configuration folder of your cluster add a folder for provisioning, such as `\storage\provisioning`.
2. Open IIS Manager and select Provisioning web app from the tree view.
3. Select Advanced Settings from the right pane menu and edit the Location to point to the folder you added to the shared location folder. The location should be entered as a UNC pathname.

4. In the Physical Path Credentials field, enter the user credentials of a domain user that will have read-write access to the shared location.

5. Hit OK to apply the changes.

Accessing Shared Cluster Configuration Resources

Because each cluster node is accessing shared network resources using a UNC path, you will need to define a qualified user for your application server and select IIS AppPools. This is easily accomplished using the Configuration Wizard. The “Choose credentials” pane of the Configuration Wizard allows you to specify the user name and password of the authenticated user that has access to the shared resources from which you will access data. If you failed to specify this user when you initially ran the Configuration Wizard, you may simply run the wizard again to update the credentials.

Configure Application Request Routing (ARR)

Microsoft's ARR is the load balancer used by ERDAS APOLLO Advantage / Professional. It defines the rules for routing all ERDAS APOLLO requests to the cluster nodes. ARR is a very powerful system and is highly configurable. The follow sections outline one example of how to configure a cluster using ARR.

Application Request Routing (ARR) Installation and Configuration

**NOTE** The following instructions assume you are using IIS 8.0 or later.
1. Start Internet Information Services (IIS) Manager and select **Get New Web Platform Components** from the **Actions** pane on the right.

   ![Internet Information Services (IIS) Manager](image)

   **TIP** If you don't see the **Get New Web Platform Components** visit the **Microsoft Web Platform Installer 5.0** site.

2. **Search Results for Application Request Routing**

   Enter "Application Request Routing" into the search string into the Web Platform Installer.
3. Click **Add** for *Application Request Routing 3.0*, then **Install**.

4. Click **I Accept** to install prerequisites.
5. Exit Internet Information Services (IIS) Manager then restart Internet Information Services (IIS) Manager. Look for the Server Farms entry.
6. Right click on **Server Farms** and then select **Create Server Farm...** from the pop-up menu.

7. **Server Farm Name**
The initial server farm created will be used to load balance longer running ERDAS APOLLO requests. An additional server farm will be defined later to accommodate shorter duration requests. Server farm names can be anything. For this example, enter "APOLLO-Services". Click Next.

8. **Server Address**
Add server nodes to the farm (these are the cluster nodes). Enter the server address then click **Add**. If your server node uses anything other than port 80 for ERDAS APOLLO, refer to step 10 below for additional instructions before adding that specific node.
9. Continue adding server nodes to the farm. Click **Finish** when you’ve entered the last node.
10. With ARR, you can use one of your cluster nodes as the client address, or entry point, for your cluster. If you are going to use this configuration, you must arrange your ERDAS APOLLO server instance to use a different port than your cluster entry-point. You need to install and configure ERDAS APOLLO on a separate site/port. In this case, we have installed ERDAS APOLLO on a site that is configured to listen to port 81. When you specify this node while creating your server farm, click **Advanced settings**... then enter the port in the **httpPort** field.
11. When you are done creating your cluster nodes for this server farm, you will be presented with the following question concerning URL rewrite rules. This example will go through the process of creating several URL rewrite rules. Click No so no default rule will be created.

12. Click APOLLO-Services, and then double-click Routing Rules.
13. Now click **URL Rewrite...** under **Advanced Routing** in the right pane.
14. Click **Add Rule(s)...** under **Actions** in the right pane.
15. Click **Blank rule** under **Inbound Rules** then **Ok**.

![Add Rule(s) window showing Blank rule selected](image)

16. **Edit Inbound Rule**

   **Name** - Enter "APOLLO-Services".
   
   **Using** - Select **Wildcards** from the drop-down menu.
   
   **Pattern** - Enter "*erdas-apollo*services*" as the wildcard pattern.
   
   **Action type** - Click the drop-down arrow and select **Route to Server Farm**.
   
   **Server farm** - Select **APOLLO-Services** from the drop-down menu.
   
   Check the **Stop processing of subsequent rules** check box.
Click **Apply**.
17. If your server farm(s) are on the same server as one of your ERDAS APOLLO cluster
nodes, you must add a condition. Click the arrow to expand Conditions and then click Add...

**Condition input** - Enter "\{SERVER_PORT\}"

**Pattern** - Enter "80". This condition will only reroute request coming in on port 80.

Click OK.

18. When you are finished defining this URL rewrite rule, click Apply.
Set up Load Balancer for Web Applications and Services

So far, we have created a server farm that will load-balance all of the longer running ERDAS APOLLO requests within our cluster. ERDAS APOLLO is made up of several web applications and services. We need to load balance all of those requests as well. Now, we need to create another server farm that will load balance all other requests within our cluster.

1. Create another server farm named “APOLLO-Other” similar to what you have already done for “APOLLO-Services”.

2. Create a URL rewrite rule that will route all other requests to the “APOLLO-Other” server farm. Be sure to add the condition to only route port 80 requests if your server farms are on a cluster node.

   Name - Enter APOLLO-Other

   Using - Select Wildcards from the drop-down menu.

   Pattern - Enter * as the wildcard pattern.

   Action type - Click the drop-down arrow and select Route to Server Farm.

   Server farm - Select APOLLO-Other from the drop-down menu.

   Check the Stop processing of subsequent rules check box.

The web applications that come with ERDAS APOLLO contain session state. This requires that either we configure them to share session state across clusters, or we constrain requests within a user session to be routed to the same server. The simpler configuration is the latter. We still get load balancing for different user sessions without the overhead of shared session state. Additionally, the WMS services within ERDAS APOLLO cache information for performance. Constraining a user's requests within a session to a node
allows the cache to be more effective. Constraining requests within a user session to a single cluster node can be accomplished by setting client affinity within the server farm.

1. In this example, click APOLLO-Other then double-click Service Affinity.

2. **Client affinity**
Check **Client affinity** and then click **Apply**.

ARR supports many load balancing algorithms out of the box. Our goal in this example is to independently load balance both long and short running requests evenly across the cluster. To do this independently, we created two server farms. To load balance evenly across all nodes, we need to use a round robin approach with even distribution to all nodes.
3. Click APOLLO-Other server farm, then double-click Load Balance.

![Server Farm Interface](image)

4. **Load Balance Algorithm**
   
   Select **Weighted round robin**.

5. **Load distribution**
Make sure **Even distribution** is selected then click **Apply**.

6. Do the same for the **APOLLO-Services** server farm.

At this point, your cluster is ready to start receiving requests and routing them to cluster nodes.

**Additional Configuration**

This section lists additional configuration for the ERDAS APOLLO installation.

**Change Multicast Address**

After you install the cluster you can change the multicast address manually. Make these changes on every node in the cluster.

**Navigate to** `<APOLLO_HOME>/webapps/erdas-apollo/WEB-INF/classes`

1. Open `ehcache.xml`.
2. Change the address in the string: `multicastGroupAddress`.
3. Save the file.

If you have selected JBoss as your application server:

1. **Navigate to** `<APOLLO_HOME>/jboss/standalone/configuration`.
2. Open `standalone.xml`. 
3. Go to `<socket-binding-group>` section.
4. Change the multicast address for `jgroups-mping` and `jgroups-udp` interfaces to the new value.
5. Save the file.
6. Restart the ERDAS APOLLO JBoss application server on each of the cluster nodes.

If you have selected Tomcat as your application server:
1. Restart the ERDAS APOLLO Tomcat application server on each of the cluster nodes.

Centralized Logging

In a clustered installation, an additional appender is defined in each of the cluster nodes to ensure a unified and centralized logging for the whole cluster. This is done using the `SyslogAppender`, a network appender that sends logging information to any syslog daemon on the network.

Using that appender, all JBoss nodes send their log message to a Syslog daemon (which must be started and listening on the network). That Syslog daemon is able to display in real-time messages coming from every node, and can redirect that centralized log to a single log file.

To be fully functional, the Syslog appender has to be configured within the ERDAS APOLLO logging configuration file. This step is done during the Cluster section of the installation process, when you are asked for the following information.

- **Syslog Daemon Host**
- **Syslog Daemon Port**

The Syslog daemon itself, which will receive all messages sent by the log4j Syslog Appender, is not installed/configured during the Installation process. Syslog daemons are available on almost all servers (there are several free or commercial implementations of Windows syslog daemon).

Testing Your Installation of ERDAS APOLLO Server

The ERDAS APOLLO products come with a web tools welcome page that is installed and published when you install any version of the ERDAS APOLLO Server.

If you have successfully installed the product, you will see the welcome page when you visit the following web address:

```
http://<server_name>:<portnumber>/erdas-apollo
```

From the Welcome Page you can test the installation of the other server features as listed below.

- **Click Geospatial Portal** to run Geospatial Portal. See the Geospatial Portal User Guide for more details on using Geospatial Portal.
Installing and Configuring ERDAS APOLLO

- Click **Catalog Web Interface** to run the ERDAS APOLLO Catalog Web Interface. See the ERDAS APOLLO Server User Guide for more details on the ERDAS APOLLO Catalog Web Interface.

- Click **Administration Console** to run the Geospatial Server Administration Console. See the Administration Console User Guide for more details on using the Geospatial Server Administration Console.

- Click **Tools** to access various ERDAS APOLLO and ECW tools.

- Click **Documentation** to access the ERDAS APOLLO and Geospatial Portal User Guides and Administration Guides.

- Click **Examples** to access various ERDAS APOLLO, ECW, and Geospatial Portal examples.

Installing ERDAS APOLLO Data Manager

After you have installed ERDAS APOLLO and you have verified that it is running, install the ERDAS APOLLO Data Manager. You can install ERDAS APOLLO Data Manager on the ERDAS APOLLO server or any other computer that has a network connection to the ERDAS APOLLO server.

1. Insert the software DVD into your DVD drive. The Setup Manager dialog opens.
2. Click **ERDAS APOLLO Data Manager 2015**, then **Install** under New Software.
3. Click Next and the License Agreement dialog opens.
4. Review the license agreement and click I accept, then **Next**. The Custom Setup dialog opens.

   Click **ERDAS APOLLO Data Manager**.
   
   - Click **Change...** to change the install location.
   - Click **Space** to see the required disk space for the ERDAS APOLLO Data Manager installation and the free space on your computer.
   - Click **Back** to return to the License Agreement.
   - Click **Next** to continue the installation.

   The Ready to Install the Program dialog opens.
5. Click **Install** and the Installing Intergraph ERDAS APOLLO Data Manager dialog opens. When complete, the InstallShield Wizard Completed dialog opens.
6. Click **Finish** to exit the installation.
The ERDAS APOLLO Data Manager User Guide can be accessed as online help directly within the application. It is also available as HTML help which can be accessed from the Documents subpage of the ERDAS APOLLO server Welcome page:

http://<server_name>:<portnumber>/erdas-apollo/ERDAS%20APOLLO%20Data%20Manager%20User%20Guide
Upgrading ERDAS APOLLO

You cannot install ERDAS APOLLO 2015 if you have a previous version of ERDAS APOLLO installed. You must first uninstall the older version, but there are considerations to be made to safeguard you from losing important data and information. If you are upgrading from a version of ERDAS APOLLO older than 2011, contact customer support. The following sections detail the supported upgrade scenarios:

- Upgrading from ERDAS APOLLO 2011
- Upgrading from ERDAS APOLLO 2013
- Upgrading from ERDAS APOLLO 2013 SP1
- Upgrading from ERDAS APOLLO 2014
- Upgrading from ERDAS APOLLO 2014 SP1

If you are using the default location for your ERDAS APOLLO configuration files, such as C:\Program Files\Hexagon\ERDAS APOLLO\storage, make a backup of those files before you uninstall the previous version. You should also use the Administrative Tools > Services command to verify that the Geospatial Server Administration Console Service is running before you uninstall ERDAS APOLLO 2013 SP1 or later.

**IMPORTANT** If you have customized any ERDAS APOLLO parameters and you want those customized values to be migrated to your ERDAS APOLLO 2015 system, you must run the SaveProperties.bat utility as described in Migrating Customized Properties to ERDAS APOLLO 2015 (on page 97) before uninstalling your existing version of ERDAS APOLLO.

In This Section

Upgrading from ERDAS APOLLO 2011 ........................................... 93
Upgrading from ERDAS APOLLO 2013 ....................................... 94
Upgrading from ERDAS APOLLO 2013 SP1 or later ..................... 95
Migrating Customized Properties to ERDAS APOLLO 2015 ....... 97

Upgrading from ERDAS APOLLO 2011

**IMPORTANT** If you have customized any ERDAS APOLLO parameters and you want those customized values to be migrated to your ERDAS APOLLO 2015 system, you must run the SaveProperties.bat utility as described in Migrating Customized Properties to ERDAS APOLLO 2015 (on page 97) before uninstalling your existing version of ERDAS APOLLO.

Uninstall ERDAS APOLLO 2011 following the instructions delivered with that version. There will be a number of files remaining on disk that you may delete when uninstall has completed. You should keep your user data, such as pyramids, metadata, and so forth.

Install ERDAS APOLLO 2015 and ERDAS APOLLO Data Manager 2015 per the instructions provided in this documentation. After the installation is complete you will be able to view the
Upgrading ERDAS APOLO

ERDAS APOLO catalog that was used previously with ERDAS APOLO 2011. However, the ERDAS APOLO Essentials IWS Catalog will be empty. You can restore it using the following steps.

**Restoring the ERDAS APOLO Essentials IWS Catalog**

**CAUTION** Install ERDAS APOLO 2015 and ERDAS APOLO Data Manager before attempting to restore your ERDAS APOLO Essentials IWS catalog.

1. Open a command prompt and change your location to `<APOLLO_HOME>/Tools/IWS`.
2. Enter the following command:
   ```
   java -jar IWSUpdateUtil.jar <APOLLO server> <port> <Apollo admin user> <password>
   ```
   **TIP** If you do not have JAVA_HOME in your system’s PATH environment variable you will need to include the path to Java.exe in your command line.
3. Open the ERDAS APOLO Data Manager and log in as admin.
4. Expand the tree view and right-click the ROOT node of the Catalog.
5. Select **Batch Update** from the right-click menu.
6. Click **OK** on the Batch Update dialog and then review the Jobs view of the ERDAS APOLO Data Manager to verify the Batch Update completed.
7. Verify that the datasets are reflected in the ERDAS APOLO Essentials Catalog with their default properties set and that the catalog hierarchy is preserved.

**NOTE** You can also choose to enable properties like WMTS when running the Batch Update command.

At this point your ERDAS APOLO configuration is ready to use.

**Upgrading from ERDAS APOLO 2013**

Upgrading directly from ERDAS APOLO 2013 to ERDAS APOLO 2015 is not supported.

To upgrade from ERDAS APOLO 2013:
- Uninstall ERDAS APOLO 2013
- Install ERDAS APOLO 2013 SP1
- Follow the steps in *Upgrading from ERDAS APOLO 2013 SP1 or later* (on page 95)
Upgrading ERDAS APOLLO

Upgrading from ERDAS APOLLO 2013 SP1 or later

When uninstalling ERDAS APOLLO 2013 SP1 or later, the configuration wizard will present you with two options, 1) Remove Configuration, and 2) Leave Configuration. The first option is preferred and recommended, but there may be good reason to leave your configuration. Please review the following sections before choosing the appropriate course of action for your configuration.

**IMPORTANT** If you have customized any ERDAS APOLLO parameters and you want those customized values to be migrated to your ERDAS APOLLO 2015 system, you must run the `SaveProperties.bat` utility as described in *Migrating Customized Properties to ERDAS APOLLO 2015* (on page 97) before uninstalling your existing version of ERDAS APOLLO.

Uninstalling ERDAS APOLLO - Remove Configuration Option

If you choose the Remove Configuration option when you uninstall ERDAS APOLLO 2013 SP1 or later, the ERDAS APOLLO Essentials IWS Catalog will be empty. You can restore it after installing ERDAS APOLLO 2015 and ERDAS APOLLO Data Manager 2015.

To upgrade using the Remove Configuration Option follow these steps:

1. Uninstall ERDAS APOLLO 2013 SP1 or later
2. Uninstall ERDAS APOLLO Data Manager
3. Install ERDAS APOLLO 2015 as described in *Installing and Configuring ERDAS APOLLO* (on page 11)
4. Install ERDAS APOLLO Data Manager as described in *Installing ERDAS APOLLO Data Manager* (on page 90)
5. Restore the ERDAS APOLLO Essentials IWS Catalog as described below.

Restoring the ERDAS APOLLO Essentials IWS Catalog

**CAUTION** Install ERDAS APOLLO 2015 and ERDAS APOLLO Data Manager before attempting to restore your ERDAS APOLLO Essentials IWS catalog.

1. Open a command prompt and change your location to `<APOLLO_HOME>/Tools/IWS`.
2. Enter the following command:
   ```
   java -jar IWSUpdateUtil.jar <APOLLO server> <port> <Apollo admin user> <password>
   ```
   **TIP** If you do not have JAVA_HOME in your system’s PATH environment variable you will need to include the path to Java.exe in your command line.
3. Open the ERDAS APOLLO Data Manager and log in as admin.
4. Expand the tree view and right-click the ROOT node of the Catalog.
5. Select **Batch Update** from the right-click menu.
Upgrading ERDAS APOLLO

6. Click OK on the Batch Update dialog and then review the Jobs view of the ERDAS APOLLO Data Manager to verify the Batch Update completed.

7. Verify that the datasets are reflected in the ERDAS APOLLO Essentials Catalog with their default properties set and that the catalog hierarchy is preserved.

**NOTE** You can also choose to enable properties like WMTS when running the Batch Update command.

At this point your ERDAS APOLLO configuration is ready to use.

Uninstalling ERDAS APOLLO - Leave Configuration Option

If you have added content to the ERDAS APOLLO Essentials Catalog apart from ERDAS APOLLO, choose the "Leave Configuration" option when uninstalling ERDAS APOLLO 2013 SP1 or later. Choosing this option removes ERDAS APOLLO while leaving the ERDAS APOLLO Essentials Catalog as well as the Geospatial Portal client and Administration Console on your system.

You may want to remove the ASP.NET cache for Apollo-Portal by removing the folder:

`C:\Windows\Microsoft.NET\Framework64\v4.0.30319\Temporary ASP.NET Files\apollo-portal`

After you uninstall ERDAS APOLLO using the "Leave Configuration" option, you can install ERDAS APOLLO 2015. The installation and configuration will create new instances of the Administration Console, ecwp, and erdas-iws web apps.

The ERDAS APOLLO 2015 installer will not upgrade your Geospatial Portal (apollo-portal) web application.

Follow these instructions to upgrade your apollo-portal instance:

1. Open a command prompt (Run as Administrator).

2. Navigate to:

   `c:\Program Files\Common Files\Hexagon\Services\Templates\Geospatial Portal\Upgrade\`


   Optionally you can use these command line options:
   - `-N` (script does not stop an application pool that hosts the instance)
   - `-T` (script does not remove temporary ASP.NET files for the instance)
   - `-C` (script does not remove cache files)

**NOTE** The original apollo-portal instance will be backed up at:

`c:\Intergraph\Geospatial Portal\backups\<dateandtime>\`

At this point your ERDAS APOLLO configuration is ready to use.
Migrating Customized Properties to ERDAS APOLLO 2015

Many of the configuration properties that were stored in configuration files in previous versions of ERDAS APOLLO are now stored and managed as part of the ERDAS APOLLO 2015 catalog database.

If you have customized your existing system by modifying any of these configuration files, you can migrate these modified properties to the ERDAS APOLLO 2015 catalog.

ERDAS APOLLO 2015 includes a SaveProperties.bat utility that allows you save selected properties and their values to a single file so that they can be automatically migrated to your ERDAS APOLLO 2015 system during configuration.

**IMPORTANT** You must run `SaveProperties.bat` on your existing ERDAS APOLLO server before uninstalling your old version of ERDAS APOLLO.

To save selected properties from your previous ERDAS APOLLO system so they can be migrated to your ERDAS APOLLO 2015 system do the following:

1. Copy the `SaveProperties.zip` to your existing ERDAS APOLLO server.
   
   `SaveProperties.zip` can be found in the following folder on your Provider_2015 DVD:
   
   `.\Repository\APOLLO-Advantage-Professional\tools\SaveProperties.zip`

   **NOTE** You can copy the `SaveProperties.zip` into any convenient location on your existing ERDAS APOLLO server.

2. Unzip `SaveProperties.zip` to a folder of your choosing.

3. Navigate into the `SaveProperties` subfolder of the unzipped archive and run `SaveProperties.bat`.

4. Enter or `Browse...` for the **ERDAS APOLLO Home** folder. If you accepted the defaults when you originally installed ERDAS APOLLO the value will be:

   - **ERDAS APOLLO 2011** - `C:\ERDAS\APOLLO2011`
   - **ERDAS APOLLO 2013** - `C:\Intergraph\ERDAS APOLLO`
   - **ERDAS APOLLO 2014** - `C:\Intergraph\ERDAS APOLLO`

5. Select the **ERDAS APOLLO Version** of the server for which you want to save the properties.

6. Select the **Clustered** checkbox if the ERDAS APOLLO server is part of a cluster.

7. Press `Find` to scan the ERDAS APOLLO home folder and generate a list of the configuration properties and their values.

8. Review the listed properties and select the ones that you would like to save (and migrate into your ERDAS APOLLO 2015 installation).

9. After you have selected all of the properties that you want to migrate, press the **Save** button. `Save Properties` will consolidate all of the selected properties and their values into a single
file called UpdateSelectedProperties.txt. You will find this file in the ERDAS APOLLO home folder.

10. **Copy** UpdateSelectedProperties.txt to a safe location. You must copy this file to your ERDAS APOLLO 2015 home folder after installing, but before configuring ERDAS APOLLO 2015.
Uninstalling ERDAS APOOL

This section assumes you are uninstalling the current release of ERDAS APOLO. You may uninstall the current version of ERDAS APOLO using the Windows Control Panel > Products and Features dialog. Removing ERDAS APOLO using the Control Panel takes you through the Uninstallation Wizard described below and removes product files from your system. You can invoke this same wizard to remove the configuration from a command prompt as described below, but you must take the additional steps to complete the uninstall and remove files from disk.

1. Open a command line window.

2. Navigate to <APOLLO_HOME>/Configwizard and enter:
   
   configurationwizard.exe -u

   The Uninstallation Wizard dialog opens.

3. Click Next and the Select uninstallation type dialog opens.

4. Select the type of uninstallation.

   Remove Configuration - removes all files and folders as well as configuration settings. The system returns to a state similar to before the software is installed, with only the following remaining.
   
   • The uninstall log file is not deleted and can be found at
     <Essentials_HOME>\PostInstallConfigurator\log.txt.
   
   • The ERDAS APOLO Essentials application pool is not deleted, in case it is being used to service the Root Application of the web site ERDAS APOLO Essentials was installed into. This is the case if JPIP is enabled during installation.

   This option removes the apollo-portal app that was deployed by the Configuration Wizard. It also stops services, deletes services, resets IIS settings, removes virtual directories (web applications), and removes all install directories and their contents.

   Leave Configuration - removes product files and folders but leaves behind files and folders associated with configurations. This option is intended for clients who want to upgrade ERDAS APOLO Essentials, while keeping their previous configurations intact. Specifically, the following are not removed.

   • Configurations files are not deleted (such as the config folder).
   
   • Projection files are not deleted (such as the ermlib folder).
   
   • The ERDAS APOLO Essentials application pool is not deleted.
   
   • ISAPI Filters settings are not removed.
   
   • ISAPI and CGI restrictions settings are not removed.
   
   • Virtual folders and applications associated with ERDAS APOLO Essentials are not removed from the website.
Uninstalling ERDAS APOLLO

This option leaves the apollo-portal app that was deployed by the Configuration Wizard. It also stops services, deletes services, removes some virtual directories (web applications), and removes all install directories and their contents.

**NOTE** The Leave Configuration option is recommended only if you have configured your ERDAS APOLLO Essentials extensively outside of ERDAS APOLLO.

5. Click **Next** and a Summary dialog shows your choices.

6. Review the summary and click **Finish** to unconfigure ERDAS APOLLO.

7. Some log files or cache files may remain in the C:\Intergraph folder. You can safely remove these now.

Removing ERDAS Foundation

Using the Hexagon Geospatial Setup Manager dialog to uninstall software is recommended because the dialog guides you to:

- Remove any updates
- Remove the software

You can use Microsoft Windows Control Panel Uninstall or change a program option as well. If you use Microsoft Uninstall, then it will remove the ERDAS Foundation [version] and any installed patches that may exist for Foundation at one time, unless you "View Installed Updates" from which updates can be installed without removing the entire ERDAS Foundation.

1. Open the Hexagon Geospatial Setup Manager dialog by using one of these methods:
   - Insert the original installer media
   - Open the original installer

2. Double click the Setup.exe file in the installer.

   The Hexagon Geospatial Setup Manager dialog opens.

3. Click the software name under **Software** to expand the software package list.
4. Click the software name to open the **Installed Software** table.

5. In Hexagon Geospatial Setup Manager dialog **Installed Software** table, click **Modify, repair, or remove**.

6. The ERDAS Foundation Welcome dialog opens. Click **Next**.

7. To remove the program, select **Remove**. Click **Next**.
   
The Remove the Program dialog opens.

8. Click **Remove** to begin the actual uninstall process.
   
   A status bar tracks the uninstall progress. When the process is finished, the InstallShield Wizard Completed dialog opens.

   Click **Finish** to exit the Wizard.
Troubleshooting ERDAS APOLLO

The ERDAS APOLLO system is designed to work with certain commonly used operating systems, third-party software packages, and network configurations and it is tested rigorously to make sure that its standard configuration options allow it to work well with them. It is also designed to be flexible enough so that it can work with many others that are not commonly used.

However, due to the variety of ways in which you can configure an operating system or network, and the many other applications you can run alongside ERDAS APOLLO, there are occasions when you may need to make some slight changes to something on your computer system in order for everything to work well together.

Troubleshooting Installation Errors

Logging Installation Errors

When an installer fails, there are a few options to get more information and act upon it:

- Create a Log file for the installation -- this can be requested by using a registry key, or by specifying command-line parameters
- Examine (and possibly Export) the Application Event Log -- gives you access to OS events generated during installation and configuration of a product

You can generate MSI (Windows Installer) and Application Event Logs.

**TIP** Turning on MSI Logging from the registry, rather than from the command line, is recommended.

*Enable Microsoft Windows Installer (MSI) Logging*

You can enable MSI logging for every installation action that happens on your system.

1. From the Microsoft Windows Start menu, click **Run**, and type regedit to open the Registry Editor.

2. Find or add the following subkey Installer in the Windows registry:
   
   HKEY_LOCAL_MACHINE > Software > Policies > Microsoft > Windows > Installer.

   **NOTE** You may need to create the Installer key.
   
   a. Insert Debug as a REG_DWORD and set its value to 7.
   
   b. Insert Logging as a REG_SZ and set its value to voicewarmup.

Once the registry strings above have been created, every time you install, repair, modify, or remove, a log file will be created in the directory identified by your TEMP environment variable.

*Creating an MSI Log for one specific installation*

**TIP** Turning on MSI Logging from the command line is a last choice effort.
Troubleshooting ERDAS APOLLO

It is highly preferred to use the registry key above to enable MSI logging, because it allows you to use your standard install, uninstall, and repair workflows. The workflow below should only be used in special circumstances, for example, if you are not allowed to update the system registry, or you really just want to create the one MSI log and you are confident you can reproduce your exact problem on the command line.

You can request a log for one specific installation, if you know the specific command-line parameters that are required to reproduce your problem. You must be quite careful, since entering wrong parameters (like omitting the ACCEPT_EULA switch required by Install in Silent Mode process) can cause your command-line installation to fail for reasons unrelated to the problem you are investigating.

Log the Installation of Product XYZ

```
msiexec /l*v "C:\Logs\InstallationXYZ.log" /i "C:\msi\XYZ.MSI" ACCEPT_EULA=1"
```

Log the Patching of a Product that already has been installed

It is also possible to log the installation of an MSP (a patch or hot-fix).

```
msiexec /l*v MyProdMSP.log /p MyProduct.msp REINSTALL=ALL
REINSTALLMODE=omus /qb
```

Viewing and Exporting Application Event Log Information

Installation and Configuration of software products generates some events that are seen by the Microsoft Windows Operating System itself. This type of logging is always available – you do not need to enable it. You can find it by launching the event viewer, and can save the events out for someone else to analyze.

1. Go to Start > Search programs and files and type in eventvwr. The Event Viewer starts.
2. On the left, open Windows Logs > Application.
3. On the right, click Save All Events As.
4. Save the file as type Event Files (*.evtx).

Hexagon Geospatial Setup Manager Logging

As noted above, logging from the registry key is highly preferred. In the case where logging from the command line is necessary, try one of these examples:

```
setup.exe /s {SoftwareProductName} /ni ACCEPT_EULA=1 /L*
MyLogFileName.log
setup.exe /s {SoftwareProductName} /ni ACCEPT_EULA=1 /L*V
MyLogFileName.log"
```

where {SoftwareProductName} is one of the Installable Applications under SoftwareProductName identified in Installable Application Names Table in Installing ERDAS Foundation in Silent Mode document.
**Tips for Resolving Issues in Installation Log**

**Component Based Servicing Log**

The Component-Based Servicing Log can be helpful if you get a message like this in your Installation log:

```
MSI (s) (44:14) []: Assembly Error (sxs): To get more diagnostic information, enable the Component Based Servicing Log.
The Component Based Servicing Log is located in %windir%\logs\cbs\cbs.log (C:\Windows\Logs\CBS)
```

To get the cbs log you may first need to set:

```
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Component Based Servicing EnableLog=dword:00000001
```

**Windows Installer SDK Tools**

Wilogutl.exe assists the analysis of log files from a Windows Installer installation, and it displays suggested solutions to errors that are found in a log file. You can use it to debug installation, repair, and removal of a product.


**Error Initializing Catalog Database by Configuration Wizard**

During installation and configuration of ERDAS APOLLO, in a case where you have had a previous version installed, you may encounter an error/warning at the conclusion of the Configuration Wizard stating “The database initialization/upgrade failed. The JBoss and DropBox services will not be started automatically. You will need to resolve these database issues before starting the JBoss service.” If this occurs, you should first review `<APOLLO_HOME>\tools\schema-generator\schema-upgrade.log to determine the possible cause. If you are able to resolve the conflict that is causing the problem, you will need to manually upgrade the schema from the command line as described below. Otherwise, contact ERDAS APOLLO customer support for assistance.

To initialize your database, follow these steps.

1. Open a command prompt, Run as Administrator.
2. Change directory to `<APOLLO_HOME>\tools\schema-generator`
3. From the command prompt, issue the following command.

   ```
   "<APOLLO_HOME>\tools\ant\bin\ant" upgrade
   ```

When the upgrade script is completed, you may start either the ERDAS APOLLO JBoss Application Server 7.1.1 or the ERDAS APOLLO Tomcat Application Server. You should also start the ERDAS APOLLO Drop Box service.
Troubleshooting Runtime Errors

Error first time connecting ERDAS APOLLO Data Manager to ERDAS APOLLO Server

Remember to install and configure Intergraph Licensing 11.11.1 (see "Licensing ERDAS APOLLO" on page 22) before you install ERDAS APOLLO Server. If you have installed it correctly and are using it correctly, you should then check to make sure you have supplied all of the proper licenses.

If you are still having the problem after you have verified the license server is running and has the correct licenses, examine the application server.

Make sure your application server is running:

1. Open the Microsoft Windows Services utility.
   
   **TIP** You can find the Services utility in the Administrative Tools section of the Windows Start menu or Start screen.

2. If you are using JBoss as your application server select ERDAS APOLLO JBoss Application Server 7.1.1.

3. Right click on the selected service and select **Restart**. (If the service has not been started, select **Start**).

   If you are still having the issue, then Windows may have allowed another application to use port number 1099, which is the one that JBoss needs.

   **To see if another application is using JBoss’ port 1099:**

   1. Open a command line window.
   2. At the prompt, type `netstat -anb | find "LISTENING"` and press Enter.
Troubleshooting ERDAS APOLLO

You may not see anything right away, because it often takes a little while for the computer to complete this task.

3. In the second column from the left, find the entry that has 1099 at the end of it. In the figure above, the entry is in the seventh row and looks like 0.0.0.0:1099.
Locate the corresponding process ID in the last column of that row. In the figure above, it is 3204.

4. In the second column from the left, find the entry that has your ERDAS APOLLO Server port number at the end of it. Usually, the port number is 8080. In the figure above, entry is in the eighteenth row and looks like 0.0.0.0:8080.

5. Locate the corresponding process ID in the last column of that row. In the figure above, it is 3204.

The process ID numbers that you found in steps 3 and 4 should be the same. If they are not, then you need to set 1099 as a reserved port in your Windows registry so that it will not allow other applications to use it.

To set 1099 as a reserved port in Microsoft Windows:

1. Open the Windows Registry editor.
   a. Click the **Windows Start** button
   b. Click **Run...** in the Start menu.
c. Type `regedt32` in the box that appears.

d. Click **OK** on the box. The Registry Editor opens.

2. In the panel on the left side of the Registry Editor, you need to open `HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters`. To do this:
   a. Open the **HKEY_LOCAL_MACHINE** node by clicking the plus sign next to it.
   b. Open the **System** node by clicking the plus sign next to it.
   c. Open the **CurrentControlSet** node by clicking the plus sign next to it.
   d. Open the **Services** node by clicking the plus sign next to it.
e. Open the **Tcpip** node by clicking the plus sign next to it.

![Registry Editor](image)

- Notice the path in the status bar.

f. Click on the word **Parameters** inside the Tcpip node. Your Registry Editor should look similar to the figure below.

3. Select **Edit > New > Multi-String Value** in the main Registry Editor menu.

A value named New Value #1 appears at the bottom of the panel on the right side of the Registry Editor.

4. Right-click the New Value #1 entry and select **Rename** on the menu that appears.

5. Type **ReservedPorts** and press Enter on the keyboard.
6. Double-click the **ReservedPorts** value. The Edit Multi-String dialog box opens.

7. Type 1099-1099 in the **Value data** box and click **OK**.

8. Exit the Registry Editor.

9. Reboot the computer.

Microsoft Windows will now keep the 1099 port available so that JBoss will be free to use that port when it needs it.

If you are still having the problem after you have checked the License Server, made sure that the JBoss application server is started, and set 1099 as a reserved port, please contact Hexagon Geospatial. Your technical support representative will be happy to provide you with further assistance.

**ERDAS Geospatial Portal link gives error.**

You may need to implement ASP.NET 4.0. Refer to Register ASP.NET with IIS.

After registering ASP.NET with IIS, you may still encounter the **HTTP Error 404.2 - Not Found** error when accessing the ERDAS Geospatial Portal.

The page you are requesting cannot be served because of the ISAPI and CGI Restriction list settings on the Web server.

To correct this problem, open the IIS Manager console and select the host node in the tree view. Open the ISAPI and CGI Restrictions utility. Notice that the entries for ASP.NET v4.0 are set to NOT ALLOWED. Select each entry individually and choose **Allow** in the Actions pane, or right-click on each entry and select **Allow** from the drop-down menu.

The ERDAS Geospatial Portal will now be accessible.
Technical Support and Information

Hexagon Geospatial provides several ways to access information and to contact support, including self-help tools and phone support.

Self-help Support Tools

Hexagon Geospatial provides several electronic self-help support tools to answer your support questions 24 hours a day, 7 days a week.

2. Under the Please Sign In heading, type your user name and password and click Login. If you are not a registered user, click the Not a Registered User? link.

To search the knowledge base:

1. In the Knowledge Search box on the left, type your question or key words for a search.
2. In the box to the right of the Knowledge Search box, begin typing the product name. Then select the product from the drop-down list. If you want to search among all products, leave the second box empty. This field is case sensitive.

To search posted documents for your product:

1. Click the Products (A-Z) tab.
2. From the Product Family list, click the link to your product family.
3. On the Family page for your product, click the link for ERDAS APOLLO.
4. Select the desired document from the Product Information list.

NOTE Release Notes and Issues Resolved might not be available for the initial release of a product because an initial release has all new features and no updated features. Some minor releases might not provide Release Notes or Issues Resolved.

Phone Support and Other Links

For support phone numbers or to submit sales inquiries, general questions, and comments, click the appropriate tabs at the top of the Hexagon Geospatial Support (http://www.hexagongeospatial.com/support) page.

Glossary

The glossary terms defined in this guide are those used in all ERDAS APOLLO guides.

A

Aggregate

A file in a format that holds several images, such as NITF.

Ant

Apache Ant is a Java-based build tool from the Jakarta Project (see Jakarta Project - http://jakarta.apache.org/).
Applet
A component that typically executes in a web browser, but can also be executed in a variety of other applications or devices that support the applet application model.

Area
A two-dimensional (area) feature represented by a line that closes on itself to form a boundary.

Bounding Box
The extent of the geographic area chosen for display or other action (such as Clip-Zip-Ship) using coordinate values of the chosen Spatial Reference System.

Connector
A class of connection to a specific type of data source.

Coordinate
One of a sequence of N numbers designating the position of a point in N-dimensional space. In a coordinate reference system, the coordinate numbers must be qualified by units.

Coordinate System
Set of rules for specifying how coordinates are to be assigned to points. One coordinate system may be used in many coordinate reference systems.

Coordinate Transformation
Computational process of converting a position given in one coordinate reference system into the corresponding position in another coordinate reference system.

Coverage
A mapping on one aspect of image data such as light pollution, elevation, or land cover.

Dimension
A OGC-WMS 1.1.1 mechanism that allows the application of a Filter in a GetMap request.

Elevation
In the context of the OGC-WMS 1.1.1 interfaces, Elevation is a parameter that can be given
in a GetMap request. It represents a given type of Dimension, a concept also explained in that specification.

Ellipsoidal
An ellipsoidal surface is a geometric surface, all of whose plane sections are either ellipses or circles.

EPSG
A type of geographic projection. The EPSG namespace makes use of the European Petroleum Survey Group tables, which define numeric identifiers (the EPSG SRS code, corresponding to the field "COORD_REF_SYS_CODE" in the EPSG database) for many common projections and which associate projection or coordinate metadata (such as measurement units or central meridian) for each identifier.

F

Feature (geographic)
Features are "abstractions of a real world phenomenon; it is a geographic feature if it is associated with a location relative to the Earth."

Feature Types
The number and kind of properties a feature has describes its feature type.

Feature Mapping
The mapping is the configuration that describes the link between the FeatureType definition and the objects returned by the underlying engine. The mapping document associated with a WFS service presents the necessary information for the WFS to convert client requests to queries understood by the data server. It also converts the result into a compliant collection of features. So, it makes the link between the internal data structure and the published information.

Feature Schema
The XML Schema associated with a WFS service gives the GML Schema (structure) needed by the WFS to expose its feature types. The schema is the type descriptions structure for each feature type and for each property of those feature types.

G

Get
A GET request is an HTTP request for exchanging information with a server. EX: GetMap, GetCapabilities

Geographic Information
Geographic Information is data that is referenced to locations on the earth's surface, such as digital maps and sample locations.
Geographic Information System
An organized collection of computer hardware, software, geographic data, and personal information designed to efficiently capture, store, update, manipulate, analyze and display all forms of geographically referenced info.

GML
GML is an open, nonproprietary language used to created geospatial objects for the purpose of data sharing. GML also serves as a data transport for geospatial objects as well as exists as a means for describing geospatial Web services.

ISO
The International Organization for Standardization (ISO) is a worldwide federation of national standards bodies from more than 140 countries, one from each country. ISO is a nongovernmental organization established in 1947. The mission of ISO is to promote the development of standardization and related activities in the world with a view to facilitating the international exchange of goods and services, and to developing cooperation in the spheres of intellectual, scientific, technological and economic activity. ISO’s work results in international agreements which are published as International Standards.

Interoperability
The ability of a system or a product to work with other systems or products without special effort on the part of the customer. Interoperability becomes a quality of increasing importance for information technology products as the concept that *The network is the computer* becomes a reality.

JDBC
Java Database Connection. The Java interfaces to database connectivity.

Java Virtual Machine
A software computer that interprets and executes the byte codes in Java class files like a microprocessor would execute machine code.

Layer
A layer is a usable subdivision of a dataset, generally containing objects of certain classes, for example rivers, roads, or geology.
Map Dressing Service
This service is provided with the ERDAS APOLLO product and appears as a provider in the WMS servlet. It places common map production elements such as a North arrow, scale bar, grid, and image border on an image.

Metadata
Metadata is often textual descriptive data about GI or other types of data. This information will often include some of the following: What it is about? Where it is to be found? Who can access it? In what format it is available? What is the quality of the data for a specified purpose? What spatial location does it cover and over what time period? When and where the data were collected, and by whom and for what purposes the data have been used?

Metadata parser
An embedded program that decodes metadata for specific satellites. ERDAS APOLLO includes several versions and your administrator can add more.

O
Open Geospatial Consortium (OGC)
An international industry consortium of more than 230 companies, government agencies, and universities participating in a consensus process to develop publicly available geoprocessing specifications.

P
Point
A zero-dimensional abstraction of an object represented by a single X,Y coordinate. A point normally represents a geographic feature too small to be displayed as a line or area; for example, the location of a building location on a small-scale map, or the location of a service cover on a medium-scale map.

Post
Post is an HTTP request for exchanging information with a server.

Provider
An instance of a connector, for a given data source.

R
Raster
Raster defines a method for the storage, processing and display of spatial data. Each given area is divided into rows and columns, which form a regular grid structure. Each cell must be rectangular in shape, although not necessarily square. Each cell within this matrix contains an attribute value as well as location coordinates. The spatial location of each cell is
implicitly contained within the ordering of the matrix, unlike a vector structure which stores topology explicitly. Areas containing the same attribute value are recognized as such, however, raster structures cannot identify the boundaries of such areas as polygons. Also raster structures may lead to increased storage in certain situations, since they store each cell in the matrix regardless of whether it is a feature or simply 'empty' space.

**S**

**Scalable Vector Graphics (SVG)**

An XML grammar for stylable graphics. Scalability infers that something can increase or decrease uniformly. SVG graphics are scalable to different display resolutions for different uses. A printed SVG graphic will use the full resolution of the printer and also display at the same size on screens of different resolutions. The same SVG graphic can be placed at different sizes on the same Web page and reused at different sizes on different pages. SVG graphics can be magnified to see fine detail. SVG graphics can also be referenced or included inside other SVG graphics to allow a complex illustration to be built up in parts, perhaps by several people.

**Service Oriented Architecture**

A way of connecting applications across a network via a common communications protocol. In theory, this lets developers treat applications as network services that can be chained together to create a complex business processes more quickly.

**Servlet Engine**

An environment written by a Web server vendor in accordance with this specification that allows servlets to run with a particular Web server.

**Shape File**

A shapefile stores nontopological geometry and attribute information for the spatial features in a data set. The geometry for a feature is stored as a shape comprising a set of vector coordinates.

**Simple Features**

Simple Features are in essence a Lite version of the ISO model corresponding to the data model required to support basic GIS systems.

**Spatial Reference System (SRS)**

A SRS is a reference system that provides a scale of measurement for assigning values "to a location, time or other descriptive quantity or quality" according to OGC.

**Styled Layer Descriptor (SLD)**

A styling language that the client and the server both understand, and that is used to portray the output of the WMS, WFS, and Web Coverage services.
Stack Trace
A list of what methods were called, in what order, to invoke the method in which the exception occurred (called a stack trace because it prints out a stack of method names).

Struts (Apache Web Application Framework)
Struts encourage application architectures based on the JSP Model 2 approach, a variation of the classic Model-View-Controller (MVC) design paradigm.

Swing, the Java Foundation Classes
The Java Foundation Classes (JFC) are a set of Java class libraries provided as part of J2SE™ to support building graphics user interfaces (GUI) and graphics functionality for Java technology-based client applications.

Usability
Usability is defined by the ease with which a user can learn to operate, prepare inputs for and interpret outputs of a system or component.

Vector
Vector defines one method of data type, used to store spatial data. Vector data is comprised of lines or arcs, defined by beginning and end points, which meet at nodes. The locations of these nodes and the topological structure are usually stored explicitly. Features are defined by their boundaries only and curved lines are represented as a series of connecting arcs. Vector storage involves the storage of explicit topology, which raises overheads, however it only stores those points which define a feature and all space outside these features is 'non-existent.'

WAR file
Web Archive file: a type of jar file used by servlets.

Webapp
Webapp or Web Application: Groups of server-side Web resources that make up an interactive online application. The Web resources include Java servlets, JSPs, static documents (such as HTML documents), and applets that can be deployed in a client Web browser. Web applications must run in the context of an Application server or Servlet Engine.

WFS
An OGC specification for a Web Feature Server.
WMS

An OGC specification for a Web Map Server.

XML Schema

Index

A
About Us • 9
Accessing Shared Cluster Configuration Resources • 69
Adding an https Binding to the ERDAS APOLLO Web Site • 18
Additional Configuration • 88
Antivirus Software Requirements • 12
Application Pools and Worker Processes • 49
Application Request Routing (ARR) Installation and Configuration • 69

B
Before You Install • 11

C
Centralized Logging • 89
Change Multicast Address • 88
Cluster Installation and Configuration • 57
Configure Application Request Routing (ARR) • 69
Configure Geospatial Portal for SSL • 53
Configure Server • 32
Configure Subcomponents for the Cluster • 68
Configure to Access Remote Data Sources • 49
Configuring APOLLO Services for SSL • 52
Configuring ERDAS APOLLO Server • 32
Configuring IIS Logging • 16
Configuring ISAPI and CGI Restrictions • 15
Configuring Secure Sockets Layer (SSL) • 16
Configuring the APOLLO Catalog WMS Service for SSL • 52
Configuring the ERDAS APOLLO Web Site • 15
Configuring the FGDB Service URL for SSL • 52
Configuring Windows Server Roles, Role Services and Features • 13
Configuring Windows Web Server (IIS) • 14

E
ERDAS Foundation • 21
ERDAS Geospatial Portal link gives error. • 111
Error first time connecting ERDAS APOLLO Data Manager to ERDAS APOLLO Server • 106
Error Initializing Catalog Database by Configuration Wizard • 105

G
Geospatial Server Administration Console • 68
Glossary • 113

I
Image Files on a Remote Windows Server or NAS • 51
Import Previous Configuration Parameters • 32
Importing a Trusted Certificate to the Local Computer • 17
Importing an SSL Certificate into IIS • 17
Installation Components • 11
Installed Folders • 30
Installing and Configuring ERDAS APOLLO • 11
Installing and Configuring ERDAS APOLLO Server • 23
Installing and Configuring ERDAS APOLLO Server in a Cluster • 54
Installing ERDAS APOLLO Data Manager • 90
Installing ERDAS APOLLO Server • 23
Installing Windows Identity Foundation (WIF) • 12

L
Licensing ERDAS APOLLO • 22
Logging Installation Errors • 103

M
Migrating Customized Properties to ERDAS APOLLO 2015 • 97

O
Overview of ERDAS APOLLO • 5
Index

P
Preparing Microsoft SQL Server for ERDAS APOLLO Configuration • 19
Preparing Oracle for ERDAS APOLLO Configuration • 19
Preparing PostgreSQL for ERDAS APOLLO Configuration • 20
Preparing Your Database • 18

R
Registering ASP.NET with IIS • 14
Removing ERDAS Foundation • 100

S
SDI Services (WMS) • 68
Set up all subsequent nodes in the Cluster • 63
Set up Load Balancer for Web Applications and Services • 84
Set up the first node in the Cluster • 57

T
Technical Support and Information • 113
Testing Your Installation of ERDAS APOLLO Server • 89
Troubleshooting ERDAS APOLLO • 103
Troubleshooting Installation Errors • 103
Troubleshooting Runtime Errors • 106

U
Uninstalling ERDAS APOLLO • 99
Uninstalling ERDAS APOLLO - Leave Configuration Option • 96
Uninstalling ERDAS APOLLO - Remove Configuration Option • 95
Upgrading ERDAS APOLLO • 93
Upgrading from ERDAS APOLLO 2011 • 93
Upgrading from ERDAS APOLLO 2013 • 94
Upgrading from ERDAS APOLLO 2013 SP1 or later • 95